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1 Pro64 Network Manager User Guide

Welcome 
Version 3 of Aviom Pro64® Network Manager™ is a software application designed to manage and 
configure Pro64 digital snakes and audio networks from a central location. Pro64 Network Manager 
simplifies system installation and device setup while at the same time unlocking flexibility not accessible 
from the front panel user interfaces. All Pro64 device are powered by A-Net®, Aviom’s proprietary audio 
distribution and networking technology that is designed specifically for the unique demands of data-
intensive streaming audio.

Pro64 Network Manager connects to a Pro64 digital snake or audio network via RS-232 (or USB when 
connected to AllFrame Multi-modular I/O System™ products) and makes use of the network’s built-in 
Managed Mode to simplify tasks related to supporting and configuring Pro64 networks. 

All network settings can be monitored, including channel activation and Slot assignment, internal/external 
clock source and sample rate, m-control™, firmware versions and updates, Virtual Data Cables™, and 
channel naming.  

Pro64 Network Manager helps users track and allocate network resources more efficiently, speeds 
configuration of systems and I/O devices, and simplifies troubleshooting and network maintenance.  

 

P  Note:  Manual Mode systems are not supported in this version of the application. 

PRO64® 
Network Manager™
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Firmware Notice

Version 3.0 (and above) of the Pro64 Network Manager application introduces 
support for the C4dio card and external clocking options for the AllFrame Multi-
Modular I/O System. All Pro64 devices must be updated to the most recent firmware 
(version 5.0 or higher) to be managed and controlled by the Pro64 Network Manager 
Version 3 software. 

Use Pro64 Network Manager’s built-in Firmware Update utility to update all devices 
in the Pro64 network before proceeding. 

Pro64 devices with firmware version 4 and earlier (referred to in this document as v2.xx, 3.xx, and 4.xx) 
are only compatible with the firmware update utility in the Pro64 Network Manager application until they 
are updated to firmware version 5.0 or higher (referred to in this document as v5.xx). Settings on Pro64 
devices running older firmware versions (v4.xx and before) cannot be controlled by this version of the 
Pro64 Network Manager software. 

P  Note: You cannot manage and control a network made up of Pro64 devices whose firmware is a mix of 
old and new firmware versions. 

Updating firmware requires a direct RS-232 connection between the PC and the Pro64 network’s Control 
Master device. Normally this is accomplished by connecting a null modem DB9 cable between the RS-232 
jack on the computer and the Pro64 device. In the case of an F6 Modular I/O Frame (part of the AllFrame 
system), a USB connection is required if the F6 is used as the network’s Control Master. Firmware updates 
take about 3-5 minutes per module. (See page 13.)

Computers lacking a serial port connection may require the use of a USB-to-RS-232 adapter to update 
non-AllFrame devices. See page 21 for complete update details.  
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Overview

The following is an overview of the steps required to start managing and controlling your Pro64 audio 
networking products with Pro64 Network Manager.

Download the current version of the Pro64 Network Manager Version software •	
installer from the Aviom website (www.Aviom.com).

Install the Pro64 Network Manager application. (See page •	 7.) 

Connect the Pro64 network to the PC with a DB9 null modem cable, compatible •	 USB-
to-RS-232 adapter, or USB cable when using AllFrame devices.  (See page 21.) 

Configure the network’s Control Master so that it can communicate with the software. •	
(See page 22.) 

Launch Pro64 Network Manager for the first time. (See page •	 28.) 

Update the firmware in any Pro64 devices that have outdated firmware installed.   •	
(See page 30.) 

When all firmware is updated, start managing the Pro64 network.  (See page •	 13.) 

Explore the features and functions of Pro64 Network Manager including projects •	
(page 37), the Network Overview (page 15), Device Windows (page 16), and the Scene 
Manager (page 120). 

After installing the Pro64 Network Manager application you can choose to work offline with the included 
demo projects to become familiar with the features of Pro64 Network Manager prior to updating firmware 
and working online. See page 12 for additional information.    

 

The Pro64 Network Manager workspace  

www.Aviom.com
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What’s New in Version 3.0 
If your system is already running Version 2 of Pro64 Network Manager, the Version 3 release introduces the 
following new features and functionality:  

Hardware support for the •	 C4dio card for the AllFrame—a firmware update to the 
AllFrame F6 is required to allow the cards to be recognized.  See page 72.

AllFrame devices now support •	 external clocks (requires at least one C4dio card to be 
installed). 

External sync via •	 Word Clock and AES3 clocks are supported when a C4dio card is 
installed in an AllFrame. 

Optional •	 sample rate converters (SRC) are available when a C4dio card is installed in 
an AllFrame F6 allowing external devices with digital outputs such as CD players to be 
connected to a Pro64 network.  See page 73.

The AllFrame Device Window has new features that support C4dio cards installed •	
in the F6 including Sample Rate Converters on/off switches and Audio Clock Source 
menu selection options.

•	 Standby Mode is now supported for AllFrame devices in the network. See page 75.

Three methods of Standby for AllFrame devices are supported—software based •	
using the Device Window in Pro64 Network Manager, from the AllFrame’s dedicated 
front panel Standby momentary switch, and hardware-based using a contact closure 
connected to the Euroblock connector on the top panel of the AllFrame.  See page 75.

Use the Firmware Update utility (found in the Tools menu of the main workspace) to update the firmware 
in your Pro64 devices to take advantage of the new hardware-related features.   
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Conventions Used in this Document
This document supports Version 3 (and above) of the Aviom Pro64 Network Manger software; it will be 
referred to simply as Pro64 Network Manager. 

This software revision requires that all Pro64 devices have firmware version 5.00 or higher installed in 
order to be used with this version of the software. Version 5 firmware and its variants will be referred to as 
v5.xx. Pro64 devices with older firmware versions installed cannot be used online with this version of the 
application. They will be referred to as v2.xx, v3.xx, and v4.xx.  

An AllFrame refers to the assembled unit of an F6 Modular I/O Frame plus its installed I/O cards, including 
the C4m, C4o, and/or C4dio. 
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Installing Pro64 Network Manager

It is recommended that you quit all running Windows applications before starting the Aviom Pro64 
Network Manager installation process.

Check the Aviom website (www.aviom.com) for the latest information about software and firmware 
updates and the complete line of Aviom Pro16® and Pro64® products. 

Computer Requirements 
The minimum computer system requirements for running the Aviom Pro64 Network Manager application 
are listed below.  

Windows

Intel® or AMD® processor — 1 gigahertz (GHz) or faster •	
Intel, AMD, or 100% compatible motherboard & chipset•	
Microsoft® Windows® XP with •	 Service Pack 3 (SP3), or Windows 7  
2 gigabyte (GB) RAM (32-bit systems) or 4 GB RAM (64-bit systems)   •	
125 MB of free hard disk space for full installation •	
VGA Video (1024 x 768) - 256 colors •	
DirectX 9 graphics device with WDDM 1.0 or higher driver•	
One available RS-232 port (or a USB port with a compatible USB-to-RS-232 adapter), or, •	
for AllFrame devices, one available USB port  
The free Adobe Reader (or equivalent) is required to open the included User Guide from •	
the help menu 
Microsoft .Net Framework 3.5 •	

If your PC does not have the .NET Framework 3.5 components installed, an Internet connection may be 
required to download and install these required components from the Microsoft website. 

Mac OS 

There is no official support for Pro64 Network Manager running on Apple® Mac computers. Experiments 
with a Mac running the Windows OS and the third-party Parallels software have had positive results, but 
there is no guarantee of acceptable performance at this time. The system used for the Mac tests included: 

Intel®-based Apple Mac•	
•	 Parallels software (info available from the Apple website) 

Mac OS 10.4.6 or higher•	
•	 USB-to-RS-232 converter
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Start the Installation Process
Before installing the software, disconnect the Pro64 network from the PC to avoid any conflicts with 
drivers installed by previous versions of the application. Locate the installer file, named “Pro64_Network_
Manager_Installer.exe” and double-click it to begin the installation process. If an older version of Pro64 
Network Manager is already installed on the computer, a dialog box will appear, stating that the currently 
installed version must be uninstalled before proceeding. Click Yes to continue the installation or click No 
to abort. Optionally you can choose to uninstall a previous version of Pro64 Network Manager by using the  
tools built into the Windows OS Control Panel. 

During the install, most screens give the option of navigating back to the previous step to review settings 
or make changes before continuing. To do this, click the Back button. (To exit the installer at any time prior 
to finishing, click the Cancel button; no software components will be installed.)  

Welcome Screens 
When the Welcome screens appear, click Next to continue and install Pro64 Network Manager or click 
Cancel to exit without running the installer. 

Click the Next button to continue the installation process. 
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Software License Agreement

When the Software License Agreement page appears, read the agreement completely, click the 
I accept the license agreement radio button, and then click the Next button to continue the installation. 

The Software License Agreement 

If you do not accept the software license agreement the installer will exit without installing Aviom Pro64 
Network Manager. 

Following the license agreement the current ReadMe document will be displayed. 

Enter User Information
You have the option of entering personalized information for the installation, including user and 
organization names. When installing on a computer that has multiple users, you have the option of having 
the Pro64 Network Manager software accessible to anyone or only to a specific user. Choose the option 
that best suits your needs and click its radio button. Click the Next button to continue the installation. 

Enter user information
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Choose the Installation Location
Select the hard drive and folder location on your computer where the Pro64 Network Manager software 
will be installed in the Destination Folder window. To install Pro64 Network Manager using the default 
location, simply click the Next button. To install to a different location, click the Browse button and 
navigate to and select the desired location. Click Next to continue. 

Click Browse... to install Pro64 Network Manager to a folder other than the default  location. 

Install
At this point, the installer has enough information to install the Pro64 Network Manager application and 
its supporting files. On the screen that follows, click Next to begin the installation. Click Back to return to 
the previous screen to review settings, or click Cancel to exit the installer.  

A progress bar is displayed during the installation process.
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When the install has finished installing the application components, the following screen will be displayed. 
Click Finish to complete the installation process. 

Click the Finish button to exit the installer.

The installer closes; Pro64 Network Manager is now ready to use (assuming that all required Microsoft 
updates and .NET Framework components are correctly installed). 

Launch Pro64 Network Manager by double-clicking its icon or file name in the application folder, or by 
selecting Pro64 Network Manager from within the Aviom folder in the All Programs section of the PC 
Start menu. 

P Note:  The Windows XP default location for the installation is  
C:\Program Files\Aviom\Pro64 Network Manager\Pro64_Network_Manager.exe 
 
The Windows 7 default location for the installation is  
C:\Program Files (x86)\Aviom\Pro64 Network Manager\Pro64_Network_Manager.exe
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Quitting the Installer 
At any time before the installation of Pro64 Network Manager is complete, the user has the option of 
exiting the installer. Clicking the Cancel button in one of the installer windows will stop the installation 
process. In the dialog box that appears after clicking Cancel, choose Exit Setup to stop the installer or click 
Resume to continue the installation process. 

Clicking Cancel when running the installer opens this dialog box.  

Updating or Removing the Application 
When a new version of Pro64 Network Manager is available, the old version of the application will be 
removed automatically in the process of installing a new version. 

If you want to manually remove Pro64 Network Manager, an uninstall shortcut is placed in the Pro64 
Network Manager folder automatically during the initial installation. The utility can be accessed directly 
from the Aviom\Pro64 Network Manager folder created in the Programs Menu. Optionally, the application 
can be removed by using the standard Windows OS utilities found in the Windows OS Control Panel.  

As a precaution, back up any files in the Pro64 Network Manager folder that you wish to save before 
proceeding with the uninstall and update procedure. The uninstall utility removes all program files, 
product-specific update files, application icons, log files, registry entries, and text files associated with 
Pro64 Network Manager. It does not delete any user-created files.  
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What Gets Installed
Pro64 Network Manager is installed by default into the following folder:  
C:\Program Files\Aviom\Pro64 Network Manager (Windows XP) or  
C:\Program Files (x86)\Aviom\Pro64 Network Manager (Windows 7). 

Within the Pro64 Network Manager folder, which contains the application’s resources, the following folders 
will be created. 

•	 Demo Projects – allows you to learn the application and work with each type of 
Pro64 device without being connected to a network. 

•	 Device Update – contains the current set of firmware update files (.upd) for all 
Pro64 devices

•	 Documents – documentation, licenses, and ReadMe files 
•	 FTDI USB Drivers – a backup copy of the USB driver installer (required for 

AllFrame devices) in case the driver ever needs to be reinstalled

The Update Files folder found within the Device Update folder will contain the most recent firmware 
update files for all Pro64 hardware modules, one file per product. Pro64 Network Manager looks in this 
folder by default for firmware update files (with extension .upd) for your Pro64 devices.  

The Documents folder contains the User Guide and any current ReadMe files. (The free Adobe Reader (or 
equivalent) is required to open the included User Guide from the help menu. )

P  Note:  Do not rearrange or move any of the files or folders created during the installation. 

Demo Projects 
The Pro64 Network Manager installation includes multiple demo projects. Use the demo projects to help 
you learn the application and its features as well as to explore the functions of Pro64 devices that are not 
currently in your network. 

Demo Project 1 contains at least one of each Pro64 network device along with sample Scenes and Device 
Presets that show the versatility of both the Pro64 network and the Pro64 Network Manager application. 
Demo Project  2 contains only AllFrame devices with a variety of I/O card configurations. Demo Project 3 is 
smaller, with three AllFrame devices connected to a Yamaha console. 

Experiment with recalling presets in the Device Window of a 6416m Mic Input Module, for example, to see 
its 16 channel strips change with a single mouse click.   

To preserve the original demo project’s settings as you learn the application use the Save Project As... 
command found in the File menu to save a copy of the demo project with a different name before you 
begin editing.  

P Note:  The demo projects can be opened and edited in offline mode only unless the network you 
connect to has the exact same complement of Pro64 devices installed. 
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 Network Overview Lists all Pro64 devices and their properties

v Scene Window Save and recall up to 99 network scenes

w Main Workspace Holds all other application windows such as the Network Overview and 
Device Windows

x Device Windows Displays specific information for each type of Pro64 device

y Status Bar Displays online/offline status, network mode, sample rate, and clock info

Pro64 Network Manager Interface 
The main components of the Pro64 Network Manager user interface are indicated below. 

 v

x y

w



14 Pro64 Network Manager User Guide

Pro64 Network Manager Windows

The Pro64 Network Manager application consists of the following components: 

Application •	 Workspace
•	 Network Overview

Individual •	 Device Windows
•	 Scene Manager Window
•	 Virtual Data Cable Manager Window
•	 Audio Slot Manager Window 
•	 Event Log Window 
•	 Firmware Update Window

The following section presents a brief overview of these components and the windows that make up the 
Pro64 Network Manager application. Each window, along with its features, menu items, and functions is 
described in detail in the sections that follow this overview.  

Workspace
The Workspace is the general application window that holds all other windows such as the Network 
Overview and Device Windows. The workspace cannot be closed while the Pro64 Network Manager 
application is running. The workspace can be sized and positioned on the PC desktop by the user. Closing 
the main workspace window exits the application.  

The empty main workspace before loading a project

The workspace will be blank when there is no project loaded or when the application is not connected 
online to a Pro64 network.  See page 46 for additional information. 
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Network Overview
The Network Overview shows a list of all Pro64 devices in the current network and project along with 
Slot range properties and user-defined text fields. The Network Overview can be opened/closed and 
repositioned in the workspace, or resized as needed while the application is running. The information 
displayed in the Network Overview can be sorted by column type. 

The Network Overview has a local menu bar containing functions that allow you to print a network report, 
filter devices and/or Slot ranges from the current view, etc. A Status Bar runs along the bottom edge of this 
window that displays information specific to the Network Overview such as filtering. 

The Network Overview shows the entire network configuration at a glance. 

Use the keyboard shortcut Ctrl+1 to open the Network Overview; it can also be opened by choosing 
Network Overview from the Windows menu of the main workspace. See page 52 for additional 
information. 
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Device Windows
A Device Window displays specific information for each type of Pro64 device (6416m, 6416dio, AllFrame, 
MH10, ASI, etc.). Device Windows are used to manage and edit a device’s settings such as Slot range, routing, 
channel activation, input channel names, as well as providing an interface for saving and recalling up to 16 
device presets. Each Device Window contains multiple views designed specifically for that device.

The Device Window offers multiple views of a Pro64 device’s settings.

Multiple Device Windows may be open within the workspace, but only one view for a given Pro64 device 
may be open at a time. Device Windows have their own local menu bars containing items designed to 
control settings unique to that device; you can also print a report for each device. The Device Windows can 
be opened, closed, and repositioned in the workspace as needed. 

Double-clicking a single device row in the Network Overview opens its Device Window. With a device 
highlighted in the Network Overview, using the keyboard shortcut Ctrl+D  also opens its Device Window.   
See page 63 for additional information.    
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Scene Manager Window  

A Scene saves the configuration of everything in the Pro64 network—channel on/off settings, routing, 
input channel names, and so on. The Scene Manager Window allows the user to save, recall, name, and 
manage up to 99 Scenes stored within the current project. Scenes allow the user to reconfigure an entire 
Pro64 audio network from a central location, making setup changes for multiple devices for any type of 
production easy to manage.    

The Scene Manager allows a user to create, save, and recall scenes that are part of a project.

Use the keyboard shortcut Ctrl+2 to open the Scene Manager. The window can also be opened by 
choosing Scene Manager from the Windows menu of the main workspace. See page 120 for additional 
information about Scenes.
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Audio Slot Manager Window  

The Audio Slot Manager allow the user to view the I/O routings for an entire Pro64 network from a central 
location. Each network Slot can be examined individually, with the window displaying lists of all devices 
that have assignments to the same Slot. Activation of input and/or output devices can also be managed 
from this window.     

The Audio Slot Manager provides an overview of the routing of all network Slots in a project.

Use the keyboard shortcut Ctrl+4 to open the Audio Slot Manager. The window can also be opened by 
choosing Audio Slot Manager from the Windows menu of the main workspace.  See page 117 for additional 
information.
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Virtual Data Cable  Monitor Window 
The Virtual Data Cable™ (VDC) Monitor window is used for viewing the routing of the 14 Virtual Data Cable 
Slots available in the network. 

The VDC window displays the status of the 14 Virtual Data Cable Slots. 

To open the Virtual Data Cable Monitor use the keyboard shortcut Ctrl+3 or choose Virtual Data Cable 
Monitor from the Windows menu of the workspace. See page 130 for additional VDC information.

Event Log Window
The Event Log shows text relating to network activity, errors, etc. Its contents can be saved to disk and 
portions of the log text can be copied, pasted, etc. as needed. The Event Log captures up to 256 lines of 
messages to the computer’s on-board RAM. 

The Event Log can be positioned anywhere on screen as needed. 

In the main workspace open the  Event Log by choosing Event Log from the Windows menu or by using 
the keyboard shortcut Ctrl+5. The Event Log can be opened/closed, repositioned, or resized on screen as 
needed.  

Text created by the Event Log must be saved by copying and pasting into a new desktop document if any 
portions of it need to be retained.  See page 133 for additional information.
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Firmware Update Window
The Firmware Update utility is accessed from the Tools menu in the main workspace when the application 
is online and connected to a Pro64 network. It shows a list of all Pro64 devices in the current network and 
allows their firmware to be updated.  

Firmware Update window and progress bars 

The Firmware Update utility can also be used to roll back the firmware of any Pro64 device to any previous 
firmware version.  See page 21 for additional information.
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Firmware Updates  
Firmware is the embedded software that resides in each Pro64 device. Updating firmware can be done 
one device at a time or in a batch, as would happen when connecting a version 4.xx or prior network to 
Pro64 Network Manager Version 3 for the first time. All Pro64 devices in a network should be updated to 
the most recent firmware to avoid compatibility issues. 

The Firmware Update utility is contained within Pro64 Network Manager and runs in a separate window. 
During a firmware update (and as long as the Firmware Update window is open) you cannot edit or make 
any changes in the other windows of the Pro64 Network Manager application. 

Software Notice 
Pro64 Network Manager’s Firmware Update utility replaces the Pro64 Update Tool software previously 
released for firmware management. The Pro64 Update Tool software is no longer supported.  

If you need to maintain a group of older Pro64 device’s firmware but do not need to control and manage 
your Pro64 network, you can still do firmware updates using Pro64 Network Manager without updating 
to v5.xx firmware. You will not have access to any of the other Pro64 Network Manager functionality until 
those devices are updated to v5.xx firmware. 

P  Note:  Version 5.xx firmware is required to run Pro64 Network Manager Version 3 online. . 

Update Requirements
For rack-mount I/O devices, such as the 6416m Mic Input Module, updating firmware requires a direct 
RS-232 connection between the computer and the Pro64 network’s Control Master device. Normally this is 
accomplished by connecting a null modem DB9 cable between the RS-232 jacks on the computer and the 
Pro64 device. Firmware updates take 3-5 minutes per device to complete. 

Computers lacking an integrated RS-232 COM port connection may require the use of a USB-to-RS-232 
adapter. The adapter (sometimes called a USB-to-Serial adapter) operates as a bridge between a USB port 
and a standard RS-232 Serial COM port. 

If an AllFrame device, such as the F6 Modular I/O Frame is used as the network’s Control Master, a USB 
connection is required between the F6 and the computer. 

The Appendix section of this document contains wiring and pinout information for RS-232 and null modem 
cables. See page 136.
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USB-to-RS-232 Adapters

The following USB-to-RS-232 Adapters have been tested by Aviom and found to work with the Pro64 
Network Manager application: 

Keyspan •	 USB High Speed Serial Adapter (Model USA-19HS)  Run their utility 
software to determine the COM port that is in use.  

Gigaware USB-A to Serial Cable•	  (Model 26-949)  Easy to configure; readily available 
from Radio Shack© stores. 

IOGEAR USB to Serial Converter Cable•	  (Model GUC232A)  Must configure the 
device’s baud rate and get its COM port info from within the Ports section of the 
Windows OS Device Manager; not well documented. Identifies itself as the ATEN USB 
to Serial Bridge.

CablesToGo 13in Port Authority USB Serial DB9 Cable•	  (Model 26886)  Must 
configure the device’s baud rate and get its COM port info from within the Ports 
section of Windows OS Device Manager; not well documented.

Hardware Setup For Firmware Updates  
Follow the steps below to set up the computer and the Pro64 network prior to launching the Pro64 
Network Manager application for the first time. If your network uses a 6416Y2 A-Net Interface Card* or 
AllFrame F6 as the Control Master, see the sections that follow for specific information about setting up 
these devices. 

Communication Setup For Rack-Mount I/O Devices 
To set up Pro64 rack-mount I/O devices such as the 6416m, 6416dio, and 6416o for updating:  

•	 Connect an RS-232 serial cable (null modem) or properly configured USB-to-RS-232 
adapter between the PC and the Pro64 network’s Control Master device. You may 
need to configure the PC’s COM port settings for some USB-to-RS-232 converters. 

Configure the Control Master device to communicate at 57.6k •	 baud with 8 data bits, 
one stop bit, and no parity using the DIP switches found in the RS-232 section of the 
device’s Virtual Data Cable™ (VDC) section of the rear panel as seen in the example 
below **. 

1  2  3  4  5  6  7  8  9  10

ON

1  2  3  4  5  6  7  8  9  10

ON

1  2  3  4  5  6  7  8  9  10

ON

57.6k baud DIP switch settings (DIP switch handles are black)  

•	 Disable any RS-232 or RS-422 Virtual Data Cables that are in use on the Control Master. 

On the front panel of the •	 Control Master device, press the Managed button followed 
by the Enter button. The Managed button will light yellow. 

At this point you are ready launch the Pro64 Network Manager application.•	
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*  If you are using the 6416Y2 A-Net Interface Card as the Control Master device, you can simplify the 
firmware update process by switching the Control Master function to a rack-mount Pro64 I/O device or 
AllFrame device  temporarily. 

**  The 6416dio Digital I/O Module has a 12-position DIP switch on its rear panel; DIP switch #10 is still 
used to set the device as the Control Master for the network. Leave DIP switches 11 and 12 in the down 
position. (DIP switch #12 selects between RS-232 and RS-422 communication.)  

P Note:  The DIP switch settings described above must be used any time the firmware is updated or rolled 
back on a rack-mount I/O device used as the network’s Control Master. Leave the DIP switches set 
as shown in the diagram above to simplify future updates.   

VIRTUAL DATA CABLE PORTSAC POWER

FUSE: 250VAC-F4AL

IN

OUT

1 2 3 4 1 2 3 4

RS-232
RESERVED
CONTROL  MASTER

1–8
9
10

IN OUT
ON

RS-232

1.75 AMP
PIN 1 = GND

PIN 4 = 24VDC

BACKUP POWER

GPIO INPUT
UP = ISOLATED
DN = TTL

9–16 THRU (ALT. IN) 1–8 THRU (ALT. IN)
Mic/Line Inputs (Bal) Pin 2 Hot

16 15 14 13  12  11 10  9 8 7 6 5 4 3 2 1

Mic Input Module
B A

Connect the PC to the Control Master device with an RS-232 cable.  
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Communication Setup For AllFrame I/O Devices

AllFrame Modular I/O System devices such as the F6 Modular I/O Frame do not require the user to set a 
baud rate prior to starting firmware updates. When an AllFrame device such F6 is the Pro64 network’s  
Control Master follow these steps to set up the device for firmware updates:  

Remove the •	 control panel cover on the front of the F6.  

Make sure that the Control Master switch is in the up position. •	

Connect a •	 USB cable to the Type-B USB port on the F6. 

Connect the other end of the USB cable to the PC. •	

Launch the Pro64 Network Manager application. •	

1 2 3 4

C4m

1 2 3 4

C4o

1 2 3 4

C4o

1 2 3 4
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Connect the F6 to a PC using a USB cable when the F6 is the Control Master. 
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Communication Setup for the 6416Y2 Card 

This section details the card settings required for updating firmware; they must be made on all the 6416Y2 
cards in a network before being installed in a Yamaha host device and running Pro64 Network Manager for 
the first time. DIP switch settings are slightly different if the 6416Y2 card is the network’s Control Master 
versus if it is a slave card. 

Front Panel DIP Switches

On the front panel of the 6416Y2 card, the system lock (DIP switch #9) and m-control (DIP switch #10) 
functions need to be disabled during a firmware update. To do this set DIP switch #9 and #10 up—this is 
the ‘off’ position for switches in this DIP switch block. If the network contains multiple 6416Y2 cards, be 
sure to disable m-control on each card before starting the firmware update process. Choose the front-
panel option that suits your application, then move on to setting up the card’s other DIP switches for the 
firmware update by following the steps in the section that follows. 

6416Y2 as Control Master 

RS–232/422

STEREO LINK

6416Y2

B A

ON

CTLCLKAUTO ERR

1    2     3    4    5    6     7    8     9   10  11  12

Front panel settings for a card set as Control Master; switch #12 down (DIP switch handles are black)  

6416Y2 as a Slave Device 

RS–232/422

STEREO LINK

6416Y2

B A

ON

CTLCLKAUTO ERR

1    2     3    4    5    6     7    8     9   10  11  12

Front panel settings for a non-Control Master (slave) card; all DIP switches in the up position 
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Circuit Board DIP Switches on the 6416Y2 

Before installing the 6416Y2 card in the Yamaha device, set up the card’s DIP switches as follows:  

Set DIP switch #1 in block SW8 in the down position—this sets the card to 1.	
communicate via RS-232. 

Set the card for 2.	 Managed Mode by moving DIP switch #10 found in Switch Block 9 
(SW9) to the up position. 

In order to properly communicate with Pro64 Network Manager during a 3.	 firmware 
update, all Virtual Data Cables on the 6416Y2 card need to be disabled. To do this, 
set DIP switches 2 through 7 found in Switch Block 8 (SW8) to the down position. 

In Switch Block SW4, set switches 2, 5, and 8 to the up position—this sets the 4.	 baud 
rate, stop bit, and parity for the RS-232 communication with the PC. 

The MY Mode switch (SW8, #10) can be in either position; it is shown in the 16-channel MY16 Mode (up) in 
the diagrams.  

DIP switches used for the Slot Transmit and Receive ranges (#5-8 in block SW9) can be ignored during the 
update process; they are shown in the down position in the diagrams that follow. Channel activation DIP 
switches found in DIP Switch Blocks SW1 and SW2 are also ignored during a firmware update. Those are 
shown as off (down) in the diagram. 

Once the DIP switches are set, the card can be installed in the Yamaha host device.  

ON

ON

ON

ON

ON

ON

SW7

SW8  

SW3  
SW9  

SW4 
SW1  

SW2  

1    2     3    4    5    6     7    8     9   10

1    2     3    4    5    6     7    8     9   10

1    2     3    4    5    6     7    8  

1    2     3    4    5    6     7    8  
1    2     3    4    5    6     7    8  

1    2     3    4    5    6     7    8  

Managed Mode (up)

Baud Rate 

MY 16 Mode 

RS-232 (down)

The 6416Y2 card ready for a firmware update (DIP switch handles are black)  
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After Updating 6416Y2 Firmware

Once new firmware is installed, DIP switch #9, found in DIP Switch Block 9 (SW9), is used to select between 
Pro64 Network Manager enabled (when up, the software controls all I/O routing and settings) or DIP 
switch control (when down, the card’s onboard DIP switches control the I/O routing and settings on the 
6416Y2 card). This switch needs to be in the down position for the initial firmware update from v2.xx, v3.xx, 
or v4.xx to version 5.xx. 

Move DIP switch #9 to 
the up position after 
updating the card’s 
firmware.   

Move DIP switch #1 to the up 
position after updating the 
card’s firmware for RS-422 
control.   

Leave DIP switch #10 
up after updating the 
firmware if the card 
will be Control Master.

Move it to the down 
position if the card 
is a slave or used for 
m-control.  

ON

ON

ON

ON

ON

ON

SW7

SW8  

SW3  
SW9  

SW4 
SW1  

SW2  

1    2     3    4    5    6     7    8     9   10

1    2     3    4    5    6     7    8     9   10

1    2     3    4    5    6     7    8  

1    2     3    4    5    6     7    8  
1    2     3    4    5    6     7    8  

1    2     3    4    5    6     7    8  

6416Y2 card is ready for control and management from Pro64 Network Manager after being updated. 

Leave the Managed Mode DIP switch (#10 in block SW9) in the up position on a card set to be the network’s 
Control Master. Move this switch to the down position if the card will be a slave. Remember that only one 
Pro64 device or 6416Y2 card can be the network’s Control Master, so only one card can have its DIP switch 
#10 in block SW9 set to the up position. 

If a 6416Y2 card is used as Control Master, it is not possible for that same card to send m-control information. 
The options are: (1) use a different 6416Y2 card for m-control or (2) use a different Pro64 device as the 
network’s Control Master. Switch Block SW4, the baud rate settings, can be left as is to simplify future 
firmware updates. 

P Note:  Once the 6416Y2 card’s firmware has been updated, DIP switch #9 in DIP Switch Block 9 (SW9) 
needs to be placed in the up position to enable control from Pro64 Network Manager. Power 
down the Pro64 network and the host Yamaha devices and set all 6416Y2 cards in this manner; 
restart the Yamaha devices and the Pro64 network to continue. 
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Connecting to the Network for the First Time 
Double-click the Pro64 Network Manager icon on the PC desktop, or select the application by name from 
the programs list in the Windows OS Start menu to launch the application. 

Pro64 Network Manager starts in offline mode. To connect to the network, choose Work Online... from 
the Network menu of the main workspace. In the dialog box that opens, choose the computer COM port 
where your USB cable (for AllFrame devices), RS-232 null modem cable (or properly configured USB-to-
RS-232 converter for rack-mount Pro64 I/O devices) is connected from the menu and then click OK. Pro64 
Network Manager will then scan for a Pro64 network. Click the Cancel button to continue working offline.

Choose the COM port and then click OK to connect online. 

About COM Ports
If there is more than one serial port on your PC, each valid COM port will be selectable in the drop-down 
menu. You may need to configure the COM port settings from the Windows OS Device Manager.

The Windows OS Device Manager and its COM port settings 
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When connecting to a Pro64 network running firmware versions older than v5.xx to Pro64 Network 
Manager Version 3 for the first time you will be prompted to update the firmware on all Pro64 devices 
before being allowed to control and manage the network.  

The firmware update warning 

Click Yes to open the Firmware Update window where you will be able to monitor the progress of the 
updates. Each Pro64 device takes approximately 3-5 minutes to update. (See the complete description that 
follows.) You can also use this option to view the current firmware revision of the devices in the network 
without automatically starting a firmware update.

To continue using Pro64 Network Manager without updating, click No; the application will transition to 
offline mode. You can then open and edit projects that have been saved to disk.  

P  Note: You cannot work online and view or manage a network with Pro64 Network Manager Version 3 
until all connected Pro64 devices are running v5.xx firmware.  
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Firmware Update Utility Window
The components of the Firmware Update window are described below.  

 v w x y z



The firmware update window components 

 Pro64 device type, with numeric ID and location label

v Current firmware version installed in the Pro64 device 

w Firmware checksum

x Red indicates a new firmware version is available 

y Drop-down menu to select firmware versions 

z Select box; used for choosing which devices to update 

 Click a button to start updates or exit
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Progress Bars
During the firmware update process, progress bars and an info window will be displayed. The Updating 
Devices window will show a list of all Pro64 devices that have been selected for updating. Devices will be 
listed in the Completed Devices column once their firmware has been updated. If errors occur during the 
update process, the device’s name will appear in the Failed Devices column. 

Firmware Update window progress information  

To close the Updating Devices window, click the Finish button once all firmware updates have been 
completed. To stop the update process for Pro64 devices that remain in the list, click the Cancel Waiting 
button. Note that the firmware update in progress must be completed before you will be allowed to exit.

If a Firmware Update Fails
If a Pro64 device fails the update process, try one of the following solutions:

Try a different null modem cable. •	
Check the pinout on the RS-232 cable with a multimeter.  •	
Keep all RS-232 communication cables as short as possible.  •	
Try a different •	 USB-to-RS-232 adapter.
Use a different PC. •	
Relocate the Pro64 device, making it closer to the Control Master.  •	
Minimize cable distance (including Cat-5 connections) between the Control •	
Master and the device in question.   
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Closing the Firmware Update Window
Attempting to close the Firmware Update window while an update is in progress will cause a warning 
dialog box to appear. The dialog box shows information about the current Pro64 device being updated, 
and includes an estimate for the amount of time remaining for that firmware update to complete. It also 
includes an estimate of the time required to complete all scheduled firmware updates. 

You cannot exit the firmware update utility or quit Pro64 Network Manager until at least the currently 
running firmware update is completed. 

Stop one or more updates by clicking Cancel.  

To exit the Firmware Update utility after the current update is completed and cancel all subsequent 
updates, click the Cancel button in the dialog box. To continue the update process for all devices in the 
Remaining Updates list, click the OK button. 
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Firmware Update Window Menus
When the Firmware Update window is open the following menu commands are available: 

File Menu

Print Opens the standard Windows OS printer selection dialog box and 
allows you to print a report showing the current firmware versions for all 
devices in the network  (shortcut - Ctrl+P)

Close Window Closes the Firmware Update window  (shortcut - Ctrl+W)

Firmware Report

Printing a firmware update report provides a written record of the network’s current firmware revisions. 

Firmware Update
Control Master: 6416dio

Clock Master: 6416dio
Network Mode: Auto

Clock Mode: Internal
Network Sample Rate: 48kHz

Firmware Bootloader
Device Location Version CRC Version CRC

6416dio #1 3.42 F689 0.24 7B25

6416i #1 STAGE 3.42 7FBD 1.23 33F1

6416m #1 STAGE 3.42 A860 1.04 4B2E

6416o #1 FOH 3.42 7FBD 1.23 33F1

MH10f #1 FOH 3.42 B546 1.13 33C0

MH10f 2.25 C2C3 1.13 33C0

Aviom Firmware Update Report June 30, 2010
Page 1 of 1

Sample content from a firmware report 

Update Options Menu

Locate Update Files Opens a dialog box that allows you to navigate the computer’s hard 
disks to locate the folder where the firmware update files are stored. Use 
this to choose a firmware update folder other than the default.  

Refresh Update 
Files 

This command refreshes the Firmware Update window view and should 
be used if the devices in the network or the contents of the firmware 
update files folder changes while the Firmware Update window is open.  

Use Default Update 
Files

Select this command to reset the location of the firmware updates files 
back to the default. 
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Commands in the Update Options menu  

The default location for firmware update files is:     
C:\Program Files\Aviom\Pro64 Network Manager\Device Update\Update Files 		 or  
C:\Program Files (x86)\Aviom\Pro64 Network Manager\Device Update\Update Files

This screen shot shows the default location for device update files stored in the application’s folder.  
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Maintaining a Pro64 Network 
Once a Pro64 network is updated to the current version of the firmware to work with the Pro64 Network 
Manager software, you should periodically check for new firmware update files to keep your Pro64 
products up to date. Updates are posted to the Aviom website.  (See page 21 for additional update and 
firmware information.) 

Pro64 devices with new firmware available are indicated in red.

Once new firmware files are downloaded and placed into the default firmware update file folder, any Pro64 
devices that have new firmware available are indicated with red text when the Firmware Update window 
is opened. Remember that you must be working online to be able to open the Firmware Update window. 
Use the Update All command found in the Update options menu to start the update process. Optionally, 
select individual devices to be updated by clicking in their Select boxes. 

The default location for the firmware update files is: 	  
C:\Program Files\Aviom\Pro64 Network Manager\Device Update\Update Files    (Windows XP)  
C:\Program Files (x86)\Aviom\Pro64 Network Manager\Device Update\Update Files     (Windows 7)

P Note:  If you download new firmware files from the Aviom website, be sure they are placed in the 
default Update Files folder so that they are automatically recognized by the Firmware Update 
utility when the window is opened. If updates files are stored in a different folder you will need to 
manually locate the firmware update files for each Pro64 device to be updated.  

If 6416Y2 A-Net Interface Cards are part of the network, refer to the card-specific details on page 25 for 
information on how to set up the card and update its firmware. 
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Adding Devices to a Network While Online
Adding one or more devices running outdated firmware to a v5.xx network while online will require the 
devices with older firmware to be updated in order to retain control and management of the network 
using Pro64 Network Manager. 

An outdated device has been added to the network. 

In the Network Overview window, the Status column will indicate incompatible devices with a red 
exclamation point icon (!). Device Windows for any Pro64 devices that are not updated cannot be opened. 
Projects cannot be saved or edited while such devices are connected. A dialog box opens warning of the 
incompatibility. Click OK to continue; the network will switch to offline mode. 

The network switches to offline mode when an incompatible devices is added to the network. 

To continue managing a Pro64 network online, you must either update each incompatible device or 
remove them from the network. Devices that have their firmware rolled back to previous firmware versions 
are no longer compatible with the online network and must be removed before continuing. 



37 Pro64 Network Manager User Guide

Online vs. Offline 
Pro64 Network Manager provides two ways of working with the settings and information related to a 
Pro64 network—online and offline. The Network menu in the main workspace provides the commands 
needed to go between the two states. 

Working Online
Working online means that Pro64 Network Manager is connected to a group of Pro64 devices via an 
RS-232 or USB connection with the network’s Control Master, and that the user can monitor and change 
the settings in the network. Working online allows the user to make changes to the network I/O routing 
in real time, along with providing access to the Firmware Update utility. Settings can be saved in the form 
of a project (described below). The project brings with it the option of creating and saving network-wide 
Scenes and/or device-specific presets. See page 120 for information on the use of Scenes and see page 110 
for complete information about using Device Presets.  
 

The status bar will show a green Online LED when connected to a Pro64 network. 

Working Offline
Once a project has been created, it can be edited offline without requiring the Pro64 network to be 
connected to the PC. Most Pro64 Network Manager features and functions are available while working 
offline; the Firmware Update utility is unavailable since no Pro64 hardware exists while offline. 

Projects that are edited offline can be loaded back into the Pro64 network by reconnecting to the Pro64 
network as long as the physical makeup of the network hardware is the same.   

The status bar will show a yellow Offline LED when working without an active connection to a Pro64 network. 
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The Project 
Pro64 Network Manager saves all information about the configuration of a network in a structure called a 
project. This includes:  

Quantity and type of all Pro64 devices •	 in the network  
Active •	 Slots on all I/O devices 
Input and output Slot routing, including •	 matrix settings 
Sample rate •	

•	 Control Master device
•	 Clock Master device
•	 Clock source (Network, Word Clock, AES3) 

Active •	 Virtual Data Cables (VDC)  
Device •	 Numeric ID and Location labels
Channel names •	
Network •	 Scenes

•	 Device Presets for each I/O device 
User-created text, •	 comments, etc. 
Current open •	 windows and their positions 

Only one project can be open at a time while working with Pro64 Network Manager. New projects can be 
created while connected online to a Pro64 network or by using the Save Project As... function with an 
existing project open while working offline. Projects saved to disk can be opened and edited offline at any 
time. 

Project Contents 
A project consists of a set of files and folders created as a group when you use the Save Project command 
for the first time when no project is open while working online, or when either the New Project or Save 
Project As.. command is used while an existing project is open. Projects can be stored in any convenient 
location on the computer’s hard disk. 

Saving a Project 
When connected online to a Pro64 network, you can create and save a project by using the Save Project 
command found in the File menu of the main workspace. The shortcut for this command is Ctrl+S.  

After navigating to an appropriate folder, enter a name for the project in the dialog box’s File name field 
and then click the Save button. Once a project has been created, you can create a new project using the 
same network configuration by using the New Project command found in the File menu in the main 
workspace (the shortcut is Ctrl+N).

P Note:  Do not move or rearrange the project’s sub-folders or their contents. 
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

v

Create a project in any folder (1);  name the project (2) 

The newly saved project will include all current network I/O routing, text, and user-created settings. Once 
a project has been created and saved to disk, you have the option of creating Scenes and/or Device Presets 
that become part of the project. 

The Project Structure
Each project is created in its own folder with a layout like the one shown below; it contains the project 
file itself as well as sub-folders for Project Settings, Project Scenes, and Device Presets. All Pro64 Network 
Manager projects use the .nmp file extension. 

A project’s folder structure 
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As you work with a project the application will create new Scene and Device Preset files as needed and 
store them in the sub-folders that were created with the project. When working with Scenes and Device 
Presets you will be prompted to confirm any operation that overwrites or deletes one of these files.  

Scenes vs. Device Presets 
A Device Preset saves the configuration of a single Pro64 I/O device and includes all channel names, 
channel and Slot input and/or output routing, etc., making them the ideal way to store commonly used 
settings for one device. Recalling a Device Preset will only affect the settings of the individual device. If 
recalling a Device Preset requests a network Slot resource that is already in use by another device, that 
request will be denied.

A Scene, on the other hand, stores the configuration of every device in the Pro64 network including the 
channel/Slot I/O routing for all devices, user labels and comments in the Network Overview, Virtual Data 
Cable settings, user-generated text, and notes for the Scenes themselves. 

There is no requirement to create Device Presets or Scenes when working with a project. 

The Device Presets view for a 6416m 

Scenes are a great way to simplify I/O management of a Pro64 network if you regularly use the same  group 
of configurations—a digital transfer between Recording and Broadcast studios, a Stage to FOH digital 
snake with a monitor split, connecting the DAW to the Video Room, etc. 

Each configuration saved as a Scene can be recalled quickly from within a project without the need to shut 
down the Pro64 Network Manager application or configure front-panel settings on the I/O modules. 

P  Note  Scenes are designed to change the configuration of an entire audio network with a single click of 
the mouse. Depending on the makeup of the network and the length of cabling involved, it will 
take a short amount of time to load the new configuration, during which the network’s audio will 
be muted. Pro64 Network Manager Scenes should not be confused with mixing console scenes 
and automation designed for seamless transitions in a real-time mixing environment. 
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The Scene Manager window

You can choose to work using any combination of the project file, Scenes, and Device Presets. Once a 
project has been created, all information about the current network is stored when the project is saved 
using the Save Project command in the File menu of the main workspace.   

Project Compatibility
Any projects saved to disk are checked for compatibility with the current network when they are opened 
while working online or when you attempt to transition from working offline to online. 

It is important to remember that the quantity and type of the Pro64 devices in the network as well as 
the specific Pro64 devices set as Control Master and Clock Master are directly tied to the project when 
it is created. A saved project that has any of the above-described properties different from the current 
network can be opened offline for editing but cannot be loaded into the online Pro64 network until the 
networks match. In addition, remember that an AllFrame device’s specific card configuration including the 
installed location and quantities of each card type is tied to the project. 

The makeup of the network could be different for a number of reasons including devices not being 
powered up, the addition/deletion of Pro64 devices, damaged or missing cables, etc. 

P Note:  AllFrame devices are user configurable and as such must contain the exact complement of I/O 
cards which must be installed in the same card slots within the F6 in order to remain compatible. 
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Transitioning From Online to Offline
When connected online to a Pro64 network, you can break the active connection between the host 
computer and the Pro64 network by working offline. To change from online to offline operation, choose 
Work Offline... from the Network menu of the main workspace. The RS-232 or USB connection between 
the Control Master and the PC can be removed at this point if required, and the Pro64 network itself can 
be shut down if necessary. 

Once offline, the settings in the current project can be edited as needed, and the project can be saved 
to disk as described above. New Scenes and Device Presets can be added to the project while working 
offline, as well. However, the makeup of the network cannot be changed. There is no way to remove a 
Pro64 device from the device list seen in the Network Overview. See page 53 for information on using the 
Network Overview. 

Online operation shows a green LED and offline operation shows a yellow LED in the status bar.  

Transitioning From Offline to Online
While Pro64 Network Manager is offline, there are different scenarios that will affect what happens when 
you attempt to transition from offline to online operation. The first is the easiest—there is no project open 
and the workspace is blank. Simply select the Work Online... command from the Network menu and 
connect to the network after selecting a COM port via the dialog box prompts that follow. 

Pro64 Network Manager then scans the network and uploads all the settings from the Pro64 devices into a 
new workspace that you can control, edit, and save as a project.   

Choose the COM port and then click OK to connect online.

Going Online With an Unsaved Project Open 
An unsaved project can be open offline, as would happen if you started working online first and then 
made the transition to offline without saving a project.  
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In this case the project must first be tested to check that it is compatible with the Pro64 network hardware 
that it is being connected to. (Remember, the Pro64 device list, Control Master device, and Clock Master 
device all must match.)  

Choose Work Online... from the Network menu to start the transition process. The following illustrates the 
options that are available when transitioning from offline to online without having created a project first. 

When Work Online... is selected from the Network menu, the following dialog box appears: 

The transition dialog box 

Click Cancel to exit the dialog box and continue working offline.  

Click the Save button to store the current settings to disk as a project. In the Save dialog box, navigate to 
an appropriate directory and then name and save the project. 

Click Discard to close the project that is currently open without saving changes.  

After using the Save or Discard options, the Connect to Network dialog boxes (as described previously) will 
appear. The network is now connected online. 

If you selected the Save option in the previous dialog box, the project and its settings remain open. Since 
the settings from the offline project (channel activation, channel names, I/O routing, etc.) may be different 
from the actual settings of the online Pro64 hardware’s front panels, you will be given the opportunity to 
choose which settings will be used—those from the offline project or those from the Pro64 hardware.   

The following dialog box appears: 

The Upload or Send dialog box 
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Two choices are available. Click Upload to gather the settings from the Pro64 hardware devices into the 
project. The on-screen settings (channel activation, channel names, I/O routing, etc.) may change and will 
now exactly reflect the current state of the Pro64 hardware front panels. Immediately saving these settings 
as a Scene guarantees that you can always recall the exact configuration that gets uploaded. 

The other option is to click the Send button to transfer the settings from the current project into the Pro64 
hardware devices.  

Once one of these options has been selected, the network can be edited online as needed. The Pro64 
network and Pro64 Network Manager are now in sync. 

Going Online With a Saved Project Open 
You can transition from online to offline operations as often as needed. If you start working online, save a 
project, and then transition to work offline, returning to online operation will behave as follows. 

When the Project Has Not Changed

If nothing in the project has been edited and no windows have been repositioned, etc., when Work 
Online... is selected from the Network menu, the Connect to Network dialog boxes will appear. Select the 
appropriate COM port and click OK to continue. The network is now connected online.

Once connected online, the Send Settings to Network dialog box appears: 

The Upload or Send dialog box 

Two choices are available. Click Upload to gather the settings from the Pro64 hardware devices into the 
project. The on-screen settings may change and will now exactly reflect the current state of the Pro64 
hardware front panels. Immediately saving these settings as a Scene guarantees that you can always recall 
the exact configuration that gets uploaded. 

The other option is to click the Send button to transfer the settings from the current project into the Pro64 
hardware devices.  
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When the Project Has Changed

When Work Online... is selected from the Network menu while working with a project but the project 
settings have changed, the following dialog box appears: 

 
The Save Project dialog box

Click Save to update the current project files on disk. Click Save As... to save a copy of the project with a 
different name. Click Cancel to exit the dialog box and return to working offline.  

As seen in the previous examples, the  Send Settings to Network dialog box appears next. Click Upload to 
gather the settings from the Pro64 hardware devices into the project or click the Send button to transfer 
the settings from the current project into the Pro64 hardware devices.   
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Workspace Features 
The workspace holds all other Pro64 Network Manager windows. The workspace can be sized and 
positioned on the PC desktop by the user. Closing the main workspace window exits the application. 

Workspace Status Bar 
The application’s main Status Bar shows global information in a single row along the bottom of the 
workspace window. Included are online/offline status, network mode, sample rate, clock source, as well as 
Control Master and Clock Master info. 

The workspace status bar runs along the bottom of the workspace. 

Online/Offline Status 
The first item in the Status Bar indicates the current network state—online or offline. When online 
(connected to a Pro64 network), a green icon with the text “Online” appears. When offline, the text reads 
“Offline” and a yellow icon is displayed. 

Control Master 
The Control Master section of the Status Bar is a read-only field that shows the type of Pro64 device 
currently set as the network’s Control Master along with that device’s numeric ID number. 

Network Mode
This section of the status bar displays the network mode; currently Pro64 Network Manager supports only 
Auto Mode systems. This is a read-only field. 

Clock Master
The network’s Clock Master device and its numeric ID number are shown on the right side of the Status 
Bar; this is a read-only field. 

Clock
The Clock section of the Status Bar indicates the type of clock being used by the network. This is a read-
only field. Settings displayed here can include Network Clock (internal), or External Clock. 
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Clock Errors

If a clock error occurs while synced to an external clock source, the clock type field will display the error 
condition with red text as seen below. 

A clock error is indicated in red. 

The network will continue to operate using its internal clock until the error is corrected and the external 
clock is restored, or until you intentionally reconfigure the Clock Master to use internal (Network) clock. 

Sample Rate
The Sample Rate pop-up is a user-selectable field. Click on the arrow to open a list of the available network 
sample rates from 44.1 to 192kHz. You will be prompted to confirm a network-wide sample rate change as 
this can affect the makeup of the network itself and the total number of available Slots.  

Sample Rate selection 

P Note:  Choosing a sample rate has an impact on the total number of Slots available for use in a network. 
See the documentation that came with your Pro64 devices for additional information.  

Mute All
The Mute All command will temporarily mute all audio outputs while making changes to network 
hardware, positioning microphones, etc. When activated from the command in the Network menu of the 
workspace, Mute All is shown in red in the status bar. The temporary Mute All state is not saved as part of 
the project.   (Shortcut:  Ctrl+Shift+1) 

Mute All as seen in the status bar 

P Note:  The Mute All function is not available when working with a project offline. 
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Workspace Window Commands 
Right-click the title bar of the workspace to open the standard (Windows OS) commands for resizing, 
minimizing, and closing the window. 

Right-click the title bar of the workspace to access the standard OS-level window commands. 

The window management commands duplicate those found in the workspace window’s upper right 
corner—Minimize, Maximize, and Close.  

The standard window management commands

P Note:  Using the Close command (or its keyboard shortcut Alt+F4) is the same as quitting the Pro64 
Network Manager application. 
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Workspace Menu Commands 
The menu commands found in the main workspace are described below. 

Workspace menus

File Menu
The File menu offers the following commands:

New Project Opens a dialog box that allows you to navigate to a folder on your hard 
disk and choose a storage location and name for a new project. The 
new project is based on the current network configuration. All channels 
are deactivated and channel parameters are set to factory default 
conditions.  Scenes and Device Presets are cleared.   (shortcut - Ctrl+N)

Open Project Opens a dialog box that allows you to navigate to a folder on your hard 
disk and choose a project to be opened  
(shortcut - Ctrl+O)

Save Project Saves the current project  (shortcut - Ctrl+S) 

Save Project As... Opens the Save dialog to allow you to save a copy of the current project 
with a different name  (shortcut - Ctrl+Shift+S)

Close Project Closes the current project; leaves the workspace open 

Exit Quits the Pro64 Network Manager application  (shortcut - Alt+F4)  

Network Menu 
The Network menu commands control online/offline status. 

Work Online...  Opens a dialog box that allows you to connect to a Pro64 network. Open 
projects are checked for compatibility with the online network.   

Work Offline...  When connected to a Pro64 network that is being managed online, this 
command breaks the communication connection between the PC and 
the Pro64 hardware allowing you to make edits without being physically 
connected to the network. 

Mute All Use the Mute All command to temporarily mute all audio outputs. A red 
“Mute All” is shown in the workspace status bar while the outputs are 
muted. Repeat the command to return to normal operation.
(shortcut - Ctrl+Shift+1) 

This item is not available when working offline.  
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Tools Menu 

Use the Tools menu commands to access the Firmware Update utility and preferences. 

Update Firmware... Opens the Firmware Update utility   
This item is not available when working offline.  

Preferences  Opens the Preferences dialog box

Windows Menu 
The Windows menu provides shortcuts to the application’s main windows. 

Network Overview  Opens the Network Overview window  (keyboard shortcut Ctrl+1) 

Scene Manager  Opens the Scene Manager window  (keyboard shortcut Ctrl+2) 

Virtual Data Cable 
Monitor 

Opens the Virtual Data Cable (VDC) Monitor window   
(keyboard shortcut Ctrl+3) 

Audio Slot Manager Opens the Audio Slot Manager window  (keyboard shortcut Ctrl+4)

Event Log Opens the Event Log window  (keyboard shortcut Ctrl+5) 

Close All Closes all currently open windows but does not quit the Pro64 Network 
Manager application. 

Open Windows List This section of the menu lists all currently open windows; selecting a 
window from the list will bring it to the front for editing

About the Open Windows List Contents

The contents of the Open Windows List will change as you open and close the various windows that are 
part of the Pro64 Network Manager application. Selecting any of the numbered windows with the mouse 
(or typing the corresponding number on the PC keyboard once the menu is open) will select that window 
and bring it into focus. 
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Items in the Windows menu 

Help Menu 
Application support is found in the Help menu. 

Pro64 Network 
Manager Help

Opens the User Guide for the application; the document is in PDF format 
and requires Adobe Reader or equivalent

Online Support  Launches your browser and goes to the Aviom website support area

About Pro64 
Network Manager

Opens a dialog box that shows the application version number and 
other support information. 
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Network Overview Features 
The Network Overview contains the following information about the Pro64 network and its active devices: 
Information is arranged in table format in rows and columns. Open the Network Overview from the main 
workspace by choosing Network Overview from the windows menu or by using the shortcut Ctrl+1. 

The following information is displayed: 

•	 Status – The blue A-Net icon signifies that a Pro64 device is active in the network 
•	 Device Type – 6416m, MH10, ASI, etc.
•	 Device Numeric ID – Used to help identify multiple devices of the same type
•	 Location – A user-defined field based on where a Pro64 device is installed
•	 User Label – User editable text, 16 characters maximum 
•	 Input Slot Range – The current Slot range setting for each input-capable Pro64 

device
•	 Output Slot Range – The current Slot range for each output-capable Pro64 device 
•	 Remote Control – Shows the Control Group setting for 6416m, RCI, and 6416Y2
•	 Comments – User-defined text, 256 characters maximum

The Network Overview is arranged in columns and rows; data can be sorted by clicking the column headings. 
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The Network Overview Interface 
Pro64 devices in the Network Overview can be selected singly or in groups. Click any field in a row to 
highlight a device. Shift-click to select multiple devices consecutively, or Control-click to choose non-
contiguous devices from the list. 

The Network Overview window can be resized as needed while running the application. If the Network 
Overview is made smaller than the default size, scroll bars will appear to allow any row or column to be 
brought into focus. The Network Overview can be minimized by clicking the Minimize icon in the window’s 
title bar. 

Changing Column Widths 
Columns in the Network Overview can be resized as needed. To change a column width, position the 
mouse cursor in the headings area between any two columns until a left/right arrow icon appears. Click 
and drag the separator to the desired width.   

Click and drag the column separator to change the column width.  

Sorting the Network Overview 
Information displayed in the Network Overview can be sorted as needed by clicking the column headings.  
Sorting can be ascending or descending and the current sort selection will be indicated in the column 
heading with a triangle icon. The following columns can be sorted: 

Device•	

Location•	

User Label •	

•	 Input Slot Range

•	 Output Slot Range

Status Column
A blue A-Net icon appears in the Status column to indicate an active Pro64 device. A red exclamation point 
icon (!) will be displayed if a Pro64 device with old firmware is added to the network or if a device is unable 
to communicate with the network because of corrupt firmware, hardware failure, etc.  
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The Status column also holds special icons used for the front panel lock feature (see page 55) and the LED 
Device Identify function. 

Blue icons indicate active Pro64 device, the red exclamation point indicates a device that needs to be updated. 

For 6416Y2 cards installed in Yamaha devices, a yellow A-Net icon is used to indicate a card in the network 
that is not set up for control from Pro64 Network Manager. See page 27. A gray Status icon is used to 
indicate Standby Mode for AllFrame devices. 

LED Device Identify Feature 
When working online with a Pro64 network, the LED Device Identify feature causes the front panel LEDs 
on a device to flash to help identify it, a function that is useful during system setup and firmware updates, 
especially when multiple devices of the same type are installed in the same location. The LED Device 
Identify feature is available from the Device menu or via a right-click on any row of the Network Overview.  

To activate the LED Device Identify feature for one or more Pro64 devices, first select the device(s) in the 
Network Overview. Then do one of the following: choose LED Device Identify On from the Device menu or 
right click one of the selected rows and choose LED Device Identify On from the contextual menu.  

 

  Right-click to access the menu  (left).  Three devices have their LED Device Identify function on  (right).
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When the LED Device Identify function is on, a white icon appears in the Status column of the Network 
Overview for the selected device.  

To turn off the LED Device Identify feature for an individual Pro64 device, select the device in the Network 
Overview and then choose LED Device Identify Off after right-clicking in the device’s row to select it. To 
clear all front panel flashing related to use of the LED Device Identify feature, right-click anywhere in the 
Network Overview and choose All LED Device Identify Off from the contextual menu. 

Use the shortcut Ctrl+I to activate the LED Device Identify feature and Ctrl+Shift+I to clear it.  

Front Panel Lock/Unlock
The front panel of each Pro64 I/O device in the current network can be locked from the Pro64 Network 
Manager application to prevent edits being made from the hardware’s front panels. Devices can be locked 
individually or in groups. 

The following Pro64 devices are capable of being locked:

•	 6416i Input Module

•	 6416o Output Module

•	 6416m Mic Input Module

•	 6416dio Digital I/O Module 

To lock the front panel of a compatible device, select the device in the Network Overview and then choose 
Lock Front Panel from the Device menu. When a device’s front panel is locked, a lock icon appears in the 
Status column of the Network Overview and in the status bar of its Device Window. 

The lock icon in the Status column indicates that a device is edit locked.

To lock more than one device, Shift-click or Control-click compatible device rows in the Network Overview 
to select them and then choose Lock Front Panel from the Device menu (keyboard shortcut Ctrl+L). Or, to 
lock all compatible devices without needing to select individual devices in the list first, simply choose Lock 
All Front Panels from the Device menu (or use the keyboard shortcut Ctrl+Alt+L).

To unlock one or more devices, select them in the Network Overview and then choose Unlock Front 
Panel from the Device menu (or use Ctrl+Shift+L). To unlock all locked devices without needing to select 
individual items first, choose Unlock All Front Panels from the Device menu (or use the keyboard shortcut 
Ctrl+Alt+Shift+L).

The lock/unlock commands are duplicated in the Network Overview’s right-click contextual menu for 
convenience.
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The following Pro64 devices have no Edit Lock control on their front panel interfaces and cannot be 
locked:

•	 6416Y2 A-Net Interface Card for Yamaha® 

•	 AllFrame 

•	 MH10 and MH10f Merger Hubs 

•	 ASI A-Net Systems Interface 

•	 RCI Remote Control Interface

Device Column 
The Device column lists all Pro64 devices in the network by type. Numbers can be appended to the device 
type when multiple devices of the same type are part of a network (6416m #1, 6416m #2, etc.) by changing 
the device’s Numeric ID. Click the column heading to sort devices by type. 

Numeric ID
Each Pro64 device in a network can be identified with a number (up to 3 digits). This unique ID is stored 
in the hardware itself and can only be changed from the Pro64 Network Manager application. When new 
Pro64 devices are added to a network they do not have a Numeric ID associated with them. In the Network 
Overview and Device Windows they are displayed as (New Device). 

Devices without Numeric IDs are identified as New Device 

To set (or change) a Numeric ID for a Pro64 device, select a device (6416m, 6416o, etc.) in the Network 
Overview and choose Edit Numeric ID... from the Device menu or right-click on the row and choose the 
Edit Numeric ID... command from the contextual menu.

Right-click to access the Numeric ID menu item
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In the Numeric ID dialog box enter a number from 1-999 and then click the OK button to close the dialog 
and apply the new ID number. 

Enter numbers from 1-999

The Numeric ID is stored in the Pro64 device itself until changed, and retains the setting as new projects 
are created and edited. 

P Note: Since the Numeric ID is stored in the hardware itself, it is possible to give two Pro64 devices the 
same Numeric ID. To avoid confusion when working with a network, it is suggested that each 
Pro64 device of the same type be given a unique Numeric ID. 

Control Master and Clock Master Indicators 
Two special icons are used to indicate the network’s Control Master and Clock Master devices. A red square 
icon indicates the Control Master and a yellow square icon is used for the Clock Master. 

6416dio #1 is the network’s Control Master and Clock Master. 

The Control Master designation for a Pro64 device is set on the hardware itself and cannot be changed 
from within Pro64 Network Manager. 

Filtering the Network Overview 
Pro64 devices displayed in the Network Overview can be filtered from view if desired without affecting 
network operations. To filter the list, right-click anywhere on a device row and select Filter Settings from 
the contextual menu, or use the Filter Settings... command from the View menu (shortcut Ctrl+F) to open 
the Filter dialog box. 

P Note:  Filters do not affect the makeup of the Pro64 network or the allocation of network Slot resources. 
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The Network Overview’s local Status Bar will read Filter On when any data type in the Network Overview 
is being filtered. The current filter settings are saved with the project.  

The Filter Dialog Box
You can filter combinations of devices and Slot I/O ranges from a central location by using the controls in 
the  filter dialog box, found in the View menu of the Network Overview. To access the filter, choose Filter 
Settings... from the View menu or right-click in the Network Overview and select the command from the 
contextual menu; the dialog box will open. (The keyboard shortcut is Ctrl+F) 

Set and clear filter combinations from the filter dialog box. 

Device types can be shown or hidden using the check boxes; uncheck a device type to hide it. Input and 
output Slot ranges can also be filtered from view; uncheck any range to hide it. Each sub-section of the 
filter has its own Show All button that allows the filter to be reset quickly. Once the filters are applied to 
your liking, click the OK button to close the dialog box and activate the filter. Click the Cancel button to 
exit without changing the filter settings. 

The bottom of the filter dialog box also has two global filter commands. Click Reset to return each device 
type and Slot I/O range to the default (on) state. Use Uncheck All to set all the check boxes to their off 
state, useful as a starting point when you want to create a filter with only a few parameters included. 

Location Column 
A Location is a user-defined text label in the Network Overview that is used to define where a device is 
installed in the current Pro64 network and aid in sorting and managing devices in large systems. Click the 
column heading to sort the network by Location. 
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Sort by Location by clicking its column heading. 

To add location text for a device, click in the Location field in the Network Overview for the desired device. 
When the text cursor appears, enter up to 16 characters of text. The Location label is stored in the Pro64 
device and with the project. 

Location information entered in this column is displayed in the other windows of Pro64 Network Manager 
such as the Device Windows. 

User Labels
The User Label column in the Network Overview provides a user-defined text field (16 characters or less) for 
each Pro64 device in the network. Text can be entered in the Network Overview or from a Device Window. 
User Labels are stored in the Pro64 device and get saved with Scenes and the project. 

Sort by the User Label by clicking its column heading.

Click in a User Label field in either the Network Overview of a Device Window to edit text; there is a 
16-character maximum. Press the keyboard Enter key or click elsewhere in the window to finish.  
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Input/Output Slot Range Displays
In the Network Overview, a pair of Slot Range columns show the current Slot range for each input- and 
output-capable Pro64 device. These are read-only fields. Slot ranges can be changed from the Device 
Window for each I/O device. Slot range information does not apply to network devices such as the MH10, 
MH10f, ASI, or RCI. 

Valid input and output Slot Range settings (depending on the current sample rate) include: 

1-16       (44.1/•	 48kHz, 88.2/96kHz, and 176.4/192kHz)

17-32     (44.1/48kHz, and 88.2/96kHz)•	

33-48    44.1/48kHz)•	

49-64    (44.1/48kHz)•	

•	 Matrixed  (44.1/48kHz, 88.2/96kHz, and 176.4/192kHz)

Click the input or output column heading to sort the Network Overview device list by Slot range. 

Filtering by Slot Range 
The Network Overview can be filtered by Slot range if desired. To filter the list by Slot range, choose Filter 
Settings... from the View menu.  (See page 58.) 

Remote Control 
The Remote Control column of the Network Overview shows the Control Group setting for any device 
capable of using remote control (valid settings are 1-4 and off). This is a read-only field. 

Comments Field 
The Network Overview’s Comments field is a user-defined text area that is stored with individual Scenes 
and with the project. Each Scene can recall a unique set of Comments as needed for an application. 

To add a comment, click in the Comments field for any network device. When the text cursor appears 
enter text of up to 256 characters. (Comments are not stored in the Pro64 device.)  

Enter up to 256 characters in the Comments field. 
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Network Overview Menus
This section describes the menus and commands available in the Network Overview.

File Menu
The File menu offers the following commands:

Print... Prints a report detailing the current network settings 

Print Preview Displays a preview of the information that will be printed in the Network 
Overview report

Close Window Closes the Network Overview  (shortcut - Ctrl+W) 

To print a report containing all the information shown in the Network Overview, choose Print... from the 
File menu. The standard OS print dialog box will open, allowing you to select any connected printer and 
set page properties. 

To view the report prior to printing select Print Preview from the File menu. 

Network Report 

Print a network report from the Network Overview to create a record of the current state of the network 
including all devices, location names, user labels and comments, and channel/Slot ranges. 

A sample network report

To close the Network Overview, choose Close Window or use the keyboard shortcut Ctrl+W. The project 
remains open. To reopen the Network Overview, choose Network Overview from the main workspace’s 
Windows menu (or use the keyboard shortcut Ctrl+1). 
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Edit Menu
The Edit menu in the Network Overview offers the following commands that can be used when editing 
text labels and comments

Cut Cuts the selected text  (shortcut - Ctrl+X) 

Copy Copies the selected text to the clipboard  (shortcut - Ctrl+C) 

Paste Pastes text that was copied to the clipboard  (shortcut - Ctrl+V) 

Undo Undoes the last cut, clear, or paste operation  (shortcut - Ctrl+Z)

 
These commands become active once you have entered a valid, editable text field. 

View Menu 
The View menu provides access to the Filter Settings... dialog box. (See page 58.)

Device Menu 
The Network Overview’s Device menu provides access to the LED Device Identify feature as well as the 
front panel lock/unlock feature. See page 54 for information on the LED Device Identify feature.

Open Device Window Opens the Device Window for the selected Pro64 device   
(shortcut - Ctrl+D)

LED Device Identify On Flashes the LEDs on the front panel of the selected Pro64 device to 
make it easy to identify; a white square icon is added to the Status 
column when the feature is on  (shortcut - Ctrl+I) 

LED Device Identify Off Clears the selected device’s front panel LED flashing when using the 
LED Device Identify function 
(shortcut - Ctrl+Shift +I) 

All Device Identify Off Clears the LED Device Identify flashing for all devices  (shortcut 
- Ctrl+Alt+Shift +I) 

Lock Front Panel Locks the front panel of the selected Pro64 device; a lock icon is 
added to the Status column  (shortcut - Ctrl+L) 

Lock All Front Panels Locks the front panel of the all Pro64 devices in the network; a lock 
icon is added to the Status column for each  (shortcut - Ctrl+Alt+L) 

Unlock Front Panel Unlocks the front panel of the selected Pro64 device   
(shortcut - Ctrl+Shift +L) 

Unlock All Front Panels Unlocks the front panel of all Pro64 devices  
(shortcut - Ctrl+Alt+Shift +L) 

•	
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Device Window Features

A Device Window contains the unique settings for each type of Pro64 device. Most Device Windows have 
multiple views used to simplify managing data for a specific device type, along with a local menu bar used 
for accessing commands and features related to that device. 

To open a Device Window, select a row in the Network Overview and then double click it. 

Device Windows showing the various views 

A Device Window can also be opened by using the shortcut Ctrl+D when a device’s row is selected in the 
Network Overview.  
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Window Views
 The following views are available for the Device Windows:

•	 Device Overview – the most compact view; available for all devices

•	 Inputs to Network – AllFrame, 6416i, 6416m, 6416dio, and 6416Y2 only

•	 Outputs from Network – AllFrame, 6416o, 6416dio, 6416Y2, and ASI only

Inputs and Outputs•	  – AllFrame, 6416dio and 6416Y2 only

•	 Device Presets (Show All) – AllFrame, 6416i, 6416o, 6416m, 6416dio, 6416Y2, and ASI

•	 Port Names – MH10/MH10f only 

I/O modules have multiple views available. 

Select the view you want to use from the device’s View menu. The RCI device window does not require a 
View menu; all information is displayed in its overview. 

Fields in the Device Overview 
The device type, number, location, and user label are displayed at the top of each Device Overview. These 
fields are common to all device types and mirror the text seen in the Network Overview.    

User Label
To change the User Label text, click in the label area. The text highlights; type in a new name to replace 
the existing text or use the cursor, arrow keys, backspace and delete keys to edit an existing text label. 
Changes to the User Label will be reflected immediately in the Network Overview. 
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Status Bar 
Each Device Window contains a read-only status bar along its bottom edge. A copy of the A-Net status 
icon from the Network Overview will appear in the device window along with Control Master and Clock 
Master icons as needed. 

 v
w

y

x

Device type and number (1), Location (2), User Label (3), network mode field (4), and status bar (5) 

Input/Output Grids 
Pro64 input- and output-capable devices will have I/O grids in their device windows. Bidirectional devices 
such as the AllFrame,  6416Y2 A-Net Interface Card and 6416dio Digital I/O Module will have both types.  
Exceptions are noted in the sections that follow. 

The grids serve a twofold purpose—they provide a quick overview of channel and Slot use on each Pro64 
device and they can be used to quickly activate channels and assign them to network Slots; simply click a 
channel to activate/deactivate it. 

Inputs are displayed in green, outputs are yellow. The input and output channel grids are numbered 1-16, 
corresponding to the 16 physical connections on the rack-mount Pro64 I/O devices.   

Input grid (left) and output grid (right) with Slot range drop down menus 
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AllFrame I/O Grids 
AllFrame devices have slightly different I/O grid displays because their I/O hardware is user-configurable. 
The top section of the Device Window will show a table of the installed I/O cards, using letters corresponding 
to the card’s installed location plus channel numbers on the card (A1-A4, D1-D4, etc.). Individual on/off 
switches are provided in the Input and Output grids based on the actual cards installed. Inputs or outputs 
that are not applicable to a certain card slot will be grayed out. The basic functionality of the iI/O switches 
is the same as that for the rack-mounted Pro64 I/O devices:  click to activate or deactivate a Slot. 

P Note:  An AllFrame device’s inputs are not automatically assigned to network Slots; this must be done 
using the Inputs to Network view on a per-channel basis prior to activating an input. 

The Device Overview for an AllFrame device shows its installed cards as well as the current state of all I/O slots. 
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Slot Range 

Within the Input/Output grid is a Slot range drop down menu (not available on AllFrame devices). This is 
used to assign a Pro64 device to either one of the four 16-channel Slot ranges used by the network or to 
the matrix. Available settings are Slot 1-16, Slot 17-32, Slot 33-48, Slot 49-64, or Matrixed. 

Remember that the current network sample rate affects the total number of input Slots that are available 
to be activated (64 Slots at 44.1/48kHz; 32 Slots at 88.2/96kHz; 16 Slots at 176.4/192kHz).

Choose a new Slot range from the drop down menu. 

To change a Slot range setting, click in the drop down menu and select a new Slot range or Matrixed. 
You will be prompted to confirm the change. For input devices, all currently activated channels will be 
deactivated when a new 16-channel Slot range is selected to avoid conflicts with input Slots already active 
in the network on other Pro64 devices. Activating the matrix does not deactivate the Slot assignments. 

Activating/Deactivating Channels 
To activate a channel on a Pro64 input device and thereby assign it to a network Slot, position the cursor 
over the desired channel and click an input channel to change the channel’s status. If a network Slot 
is currently in use by another Pro64 input device, a dialog box will appear to warn you of the resource 
conflict. Click OK to close the dialog box. 

Channel conflict warning
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AllFrame devices are always assigned to the matrix and have no default channel routing. Before a channel 
can be activated and assigned to the network, it must be assigned to a Slot first. 

To deactivate an active Slot on an input device, click the green channel LED; the LED will turn off and the 
resource is made available to other devices in the network.  

There are no restrictions on output modules; their channels can be turned on/off at any time. No warning 
dialogs are required. The 6416Y2 Yamaha card is an exception; its outputs are always active. 

Assigning Input Channels to the Matrix 
The matrix capabilities of Pro64 Network Manager allow any input channel on a Pro64 device to be 
assigned to any network Slot, simplifying complex routings. To access the matrix functionality, a Pro64 
device must first be set to Matrixed in the Slot range drop down, found in its Device Window. (AllFrame 
devices have their inputs assigned to the matrix by default.)

Once a device has been set to Matrixed, the Inputs to Network view changes to reveal the routing options 
for each input channel on the device. 

Once Matrixed is selected in the Slot range menu, clicking the arrow next to a Slot’s current assignment will open the 
selection menu. Select a new Slot assignment by clicking it number. 

In the Select Slot dialog box, The current Slot assignment is shown in green; available, unassigned Slots are 
displayed with standard text while Slots that are already active in the network are displayed in italics. The 
top of the Select Slot dialog box also offers the option of selecting no channel/Slot assignment, displayed 
as None. Hovering the cursor over a Slot number while the dialog box is open will show the Slot’s channel 
name and source device (if applicable) or Slot Available. 
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Control Groups 
For remote-controllable devices capable of belonging to a Control Group (6416m, AllFrame, RCI, and the 
6416Y2 card when m-control™ is active), the Control Group drop down menu will appear in the Device 
Window. Select a Control Group from the drop down menu to change the Control Group for the device 
currently being edited; available settings are Control Groups 1-4 and 'Off.' 

Control Group can be set to one of the four groups or 'off.' 

P Note:  The 6416Y2 A-Net Interface Card is always assigned to one of the four Control Groups when 
m-control is in use and has no 'off' setting available.

A device must be assigned to a Control Group to send or receive remote control information. 
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Device-Specific Features 
In addition to the common features described previously, some of the Device Windows also contain 
device-specific features that are described below. 

AllFrame 
The Device Overview for the F6 Modular I/O Frame, which is part of the AllFrame Multi-Modular I/O System 
(displayed on screen simply as AllFrame) shows which optional I/O cards have been installed into each of 
its six card slots. 

The AllFrame I/O Card table displays the installed cards for each AllFrame. 
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Cards are identified by letter, A through F, corresponding to the location in the F6 where the I/O card is 
installed. The input and output channels within an I/O card are numbered 1 through 4, and are displayed 
with the corresponding location’s letter prefix (A1-A4, B1-B4, etc.) in the Device Window. 

AllFrame I/O card locations are identified by letter.  
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AllFrame C4dio Card Support 

When a C4dio Digital I/O Card is installed in an AllFrame, the AllFrame can use external clocks in the form 
of Word Clock or the clock embedded within a digital AES3 stream. Each C4dio card installed can be a 
clock source. To support this feature, the AllFrame Device Window has an Audio Clock Source drop-down 
menu with options that correspond to the C4dio cards and their installed locations. 

Two clock options are available per C4dio card installed: Word and AES. In the drop-down menu the 
options are displayed in a list with the C4dio card’s installed location (by letter, A-F) in the F6 hardware as 
seen below.  

External clock options for a C4dio card installed into slot C of an F6  

Choose the card and clock type from the list and then confirm the change in the dialog box that opens 
once a selection has been made. The network will lock to the external clock. If the external clock is not 
present, or fails while being used, the network switches automatically to its internal clock. 
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Clock change confirmation dialog box  

When an external clock source is being used, the Device Overview for the AllFrame will display a red dot 
next to the C4dio card that is the clock source. 

An external clock source is indicated by a red dot.  

C4dio Sample Rate Converters.

The C4dio card includes sample rate converters (SRC) that allow external devices to be connected to a 
Pro64 network without clock artifacts caused by out-of-sync clocks. The sample rate converters operate in 
pairs and are on by default when a C4dio card is installed in an AllFrame. 

The Inputs to Network view contains an SRC column that shows the state of the sample rate converters; 
a yellow square indicates that a sample rate converter pair is active. The on/off state of the sample rate 
converters save with device presets. 

When the sample rate converters are active, a C4dio card cannot be used as an AES3 clock source. 
Attempting to activate AES as a clock source will result in a warning dialog box. Turn the sample rate 
converters off and try again.  

Sample rate converter warning 
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Sample rate converters on a C4dio card installed in slot F of an AllFrame  
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AllFrame Standby Options

AllFrame devices in a network can be placed into standby and remain on the network while I/O cards 
are changed. Three versions of standby are supported: software controlled from the AllFrame’s Device 
Window, from the AllFrame hardware’s front panel Standby momentary switch, or by using a wired contact 
closure connected to the Standby Euroblock connector on the top panel on the unit.  

Standby informations appears in the Device Window’s Overview. 

When an AllFrame is in standby its Status icon in the Network Overview will be displayed in gray. Changes 
to routing, mic preamp settings, output levels, etc., can still be made but will not be available until the 
AllFrame is out of standby. 

The AllFrame’s Status icon in the Network Overview is gray when the device is in Standby.  
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Standby From the Device Window

To put  the AllFrame in Standby from the Device Window while online, click the On button in the Standby 
Mode section of the Device Window. The On button lights and a yellow warning triangle icon appears. 
The AllFrame’s I/O resources are disabled, but A-Net continues to flow for all network connections. The 
device’s status icon in the Network Overview is gray while the AllFrame is in standby.   

An AllFrame placed into Standby from the Device Window

While in standby, an AllFrame’s I/O cards can be changed. However, if a saved project is open when the 
AllFrame I/O is changed, the AllFrame will no longer be compatible when it comes back online—its 
hardware complement is different.  

To return the AllFrame to normal network operation, click the Standby Mode Off button. The AllFrame’s 
I/O resources are again available to the network. 

Standby From the F6 Front Panel 

To place an AllFrame into Standby from the hardware’s front panel, press the gray momentary Standby 
button found beneath the control panel cover plate. This action duplicates the functionality previously 
described for the activation of Standby Mode from within Pro64 Network Manager—the AllFrame’s audio 
I/O resources are suspended and A-Net continues to flow for all connected network devices. I/O Cards in 
the F6 can be swapped as needed. To return the AllFrame to normal operation, press the gray Standby 
button or click the Off button in the AllFrame Device Window in the software. 

Pressing the gray front panel Standby switch performs the same function as using the software switch. 



77 Pro64 Network Manager User Guide

Standby From a Contact Closure

Standby Mode can also be activated by wiring a contact closure switch to the Standby Euroblock connector 
on the top panel of the F6 hardware. This allows a physical switch to trigger the standby state as might 
required if the AllFrame was built into an electrical enclosure with a door that was to be closed when the 
device was not in use. To differentiate this type of Standby behavior from that initiated by software or the 
momentary switch it is referred to as Hardware Standby. 

An AllFrame in hardware standby

When an AllFrame is placed into Standby Mode using a physical contact closure device, it will display a 
special lock icon in the Device Window that reads Hardware Standby Active in red along with the yellow 
warning triangle. (Notice that the Standby Mode’s radio button remains set to Off in this case.) Pro64 
Network Manager cannot change this standby state. The contact closure must be opened manually to 
return the AllFrame to normal operation.

P Note:  When an AllFrame is in Hardware Standby it cannot then be placed into software standby. 
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Hardware and Software Standby Together

Both types of Standby can be used simultaneously if the AllFrame enters the software version of Standby 
first. If while the AllFrame is in software Standby, a hardware contact closure is triggered on the same 
AllFrame device, both types of Standby will be in force. On screen in the Device Window, the Standby 
Mode On radio button with be lit and the red Hardware Standby Active will also be on. 

An AllFrame in hardware standby

To exit this state, the hardware contact closure needs to be opened manually (the software Standby will 
still be in force). Then, the software Standby can be disabled by either clicking the on-screen Off button in 
the Device Window or pushing the gray Standby momentary switch on the AllFrame hardware. 

Standby and External Clocks
When an AllFrame device is the network’s Control Master and is set to use external AES or Word Clock, 
entering standby will force the clock source to be set to Network (internal) clock while the AllFrame is in 
standby. When the AllFrame comes out of standby the external clock will again be the network’s clock 
source, as long as the C4dio card containing the clock connection is in the same physical location (slot A-F) 
in the AllFrame hardware and the external clock source is still connected. 
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AllFrame C4o Output Levels 

The analog audio outputs on an AllFrame device with one or more C4o Analog Output Cards installed can 
be set to one of five levels: +28dBu, +24dBu, +18dBu, +4dBu, or Mic. 

Use the drop-down menu to select an analog output level for a C4o output. 

Click the drop-down menu arrow to reveal the output level choices for a channel. The output level settings 
save as part of a device preset, making presets ideal for recalling frequently used configurations for an 
AllFrame device. Output level settings also save as part of the network-wide Scenes. Save a project first 
before attempting to save a Scene or Device Preset. 
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Clearing AllFrame Output Level Settings 

The Channel Settings menu contains two commands that can be used to clear AllFrame analog output 
level settings. Choose Clear Output Channel Settings to reset the selected channel back to its default, 
+24dBu. Use the Clear All Output Channel Settings command to set all analog outputs back to the default 
setting. 

The Clear Output Channel Settings commands return analog outputs to the default +24dBu setting. 

Save AllFrame output levels as part of a Device Preset or Scene to simplify device configuration and setup.  

P  Note:  The output level reset commands are only available on AllFrame devices. 
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6416Y2 A-Net Interface Card
The 6416Y2 can be set up to follow the configuration of its onboard DIP switches or to use the configuration 
sent to it from the Pro64 Network Manager application. The programmed settings from Pro64 Network 
Manager are retained even after the PC is removed from the network. 

To enable control of the 6416Y2 card via Pro64 Network Manager, set DIP switch #9 found in DIP Switch 
Block 9 (SW9) to the up position after its firmware has been updated. All 6416Y2 cards in the network must 
be set this way in order to be controllable from Pro64 Network Manager. (This switch must be in the down 
position for the firmware update.)  
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Detail view of block SW9 showing DIP switch #9 in the up position to enable Pro64 Network Manager control  

Remember that if a 6416Y2 card is the network’s Control Master, DIP switch #10 in block SW9 (Managed 
Mode on) must also be in the up position. 

When DIP switch #9 in block SW9 is in the down position, the 6416Y2 card will use the settings from its 
onboard DIP switches and no changes from Pro64 Network Manager will be allowed. The 6416Y2 card will 
still appear as a valid Pro64 device in the Pro64 Network Manager windows while online, but no changes 
to any I/O routing, configuration settings, or text edits such as channel names will be allowed until DIP 
switch #9 in block SW9 is set to the up position. 

How DIP Switch #9 Works
There is only one set of I/O routing parameters available for the 6416Y2 card at a time; DIP switch #9 chooses 
which set is used—the one programmed from Pro64 Network Manager or the one defined by the actual 
DIP switch settings on the card. Moving DIP switch #9 in block SW9 from the Pro64 Network Manager 
control enabled position (up) to local DIP switch control (down) will clear the programming performed 
from within Pro64 Network Manager until the switch is returned to the up position and the card (along 
with its Yamaha host device) is reconnected to the PC and the settings restored. 

Saving a Device Preset will help assure that settings can always be restored to a 6416Y2 card. See page 110 
for more information on using Device Presets. 
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6416Y2 Status Icon 
In the Network Overview window the 6416Y2 card’s Status column displays a blue A-Net icon to indicate 
that the card can be controlled. A non-controllable card will have a yellow A-Net status icon. The same 
status icon is seen in the card’s Device Window. 

The yellow icon indicates that the card is not controllable. 

The yellow A-Net icon indicates a card that is not controllable.    

m-control 
Using m-control to provide remote preamp control from a Yamaha device requires the user to set DIP 
switch #10 on the card’s front panel to the ‘on’ position (down) in order to activate the function; it cannot 
be activated from within the Pro64 Network Manager software. When m-control is activated for one or 
more 6416Y2 cards in the network a special icon will appear in the Device Window for each card. The 
card configuration dialog box for choosing m-control settings is available in the Tools menu of the card’s 
Device Window. See page 87 for more information.
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The m-control icon appears for any 6416Y2 card that has DIP switch #10 activated. 

Install the 6416Y2 card into Yamaha MY slot #1 when using m-control.  

A 6416Y2 card that is set to be the network’s Control Master cannot also have m-control active. If the 
network has only one 6416Y2 card installed, there are two options: set a different Pro64 device as the 
Control Master or work without m-control enabled. In a network with multiple 6416Y2 cards installed, 
simply activate m-control on a card that is not the Control Master.  

P  Note:  The m-control feature needs to be disabled during firmware updates. 

VDC Settings
When a 6416Y2 card is used as the network’s Control Master, no Virtual Data Cables can be assigned to 
that 6416Y2 card while the Pro64 Network Manager application is connected and actively managing the 
network. 
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MY8 and MY16 Modes

It is important to note that the choice to use the Yamaha MY8 or MY16 mode (8-channel versus 16-channel 
communication) must be set by the user via the 6416Y2 card’s DIP switches before installing the card in a 
Yamaha host device; it cannot be controlled via software. Refer to the 6416Y2 card and Yamaha product’s 
documentation for additional information abut the use of the two MY modes. 

In the 6416Y2 device windows, any 6416Y2 cards running in MY8 mode will have input and output channels 
9-16 disabled as seen below. 

Channels 9-16 are disabled in MY8 mode. 
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6416Y2 Output Slots 

Active Pro64 network Slots coming into a Yamaha device via a 6416Y2 card are always available to be 
output from the card to the Yamaha console. The Yamaha operator makes the choice to use a Pro64 
network resource by patching one or more Pro64 network Slots into the Yamaha device for mixing and/or 
processing as needed. For this reason, the output Slots (as seen in all device views) for 6416Y2 cards in the 
network are always on; their yellow LEDs in the Device Window cannot be changed.  

6416Y2 card output Slots are always on. 

P  Note: The 6416Y2 card’s Device Window does not allow output channels to be turned off. 

Clicking an output Slot on a 6416Y2 will cause this warning dialog box to appear. 
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6416Y2 Card Stereo Links  

Pro64 Network Manager adds simplified programming for input modules capable of using stereo links. 
However, the 6416Y2 card uses physical DIP switches on its front panel for activating a stereo link for a 
channel pair. These switches are not software controllable.  

In the 6416Y2 card’s Device Window there are no software stereo link commands available (unlike other 
Pro64 input devices), but any active stereo links will be displayed. Changes to 6416Y2 channel pairs can be 
made at any time using the DIP switches on the front face of the card; the on-screen display will update 
immediately. 

Stereo links are active on channels 3-4 and11-12.  

All channel activation rules still apply for stereo links on 6416Y2 cards—channels to be stereo linked must 
be an odd-even pair and both channels must be active in the network before a stereo link can be used.  

The Status icon will be yellow if a 6416Y2 card is configured to use the settings from its internal DIP switches 
instead of those coming from the software; a card in this state cannot be edited or controlled. This status 
icon mirrors the one seen in the Network Overview.
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Card Configuration Dialog Box 
The Tools menu for the 6416Y2 Card’s Device Window contains a shortcut to the Card Configuration dialog 
box. The settings here control the Pad Mode, Serial interface communication, and m-control channel/Slot 
options.   

The 6416Y2 Card Configuration  options 
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Card Mode

The 6416Y2 card mode can be set to either MY16 or MY8. Yamaha’s MY16 offers 16 channels at 44.1/48kHz 
while MY8 mode offers 8-channel operation, useful for Yamaha devices capable of using the 96kHz sample 
rate or when the card is used with the PM1D console. This field is read-only; the mode is set with DIP switch 
#10 in switch block SW8 on the card itself. 

m-control

The m-control field in the Card Configuration dialog box is read-only; m-control can only be activated 
from the front panel of the 6416Y2 card by placing DIP switch #10 in the down position. Using m-control 
allows remote control of Pro64 preamp settings directly from the interface of supported Yamaha devices. 

Pad Mode 

When using m-control with Pro64 remote controllable mic preamps (as found in the 6416m and AllFrame) 
there are user-selectable options that control how the 24dB pad built into the remote preamps operate. 
Two choices are available: Auto Pad and Manual Pad.  

Pad Mode options in the Card Configuration dialog box  

Choose Auto Pad to allow the remote control commands coming from the Yamaha device to automatically 
turn the Pro64 mic preamp’s pad on and off as needed. This mode provides the widest range of gain 
settings for both mic- and line-level audio sources by combining the 56dB range of the preamp with the 
24dB pad for a total 80dB gain range. Note that the pad circuitry is in the analog domain for optimal audio 
fidelity. When the pad is engaged or disengaged on the Pro64 mic preamp, audio will mute briefly while 
the pad state is changed via relays to avoid unwanted noise in the audio system. 

To separate the mic preamp gain from the pad, choose the Manual Pad setting. When using Manual Pad  
the preamp gain range is 56dB (displayed as 0 to +55 on Aviom devices). The 56dB range is mapped to the 
73 available steps of the Yamaha control. The pad must be engaged or disengaged from the front panel of 
a 6416m, from an RCI/MCS, or from Pro64 Network Manager. 

P Note:  The on-screen display of gain in a Yamaha device is limited to the interface provided the 
operator by the Yamaha operating system; the numbers displayed on the Pro64 preamp and the 
Yamaha controller will be different but the actual values and resulting audio levels will be the 
same. Yamaha displays gain range relative to the signal strength of the channel’s input, typically 
displayed as “+10” at the minimum and “-62” at the maximum range of a control’s display. 
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Serial Interface

The Serial Interface field determines how the 6416Y2 card communicates with the Yamaha host device—
either from the rear panel Remote jack of the host device via a DB9 serial cable, or from the Yamaha device’s 
backplane connector (currently required for the LS9, M7CL-ES, and CL Series consoles). 

Network Slots to be Remote Controlled

When m-control is being used, the 6416Y2 card can be set up to control any or all of the available mic 
preamps in the Pro64 network. Use the check boxes to select the group of Slots that should be controlled 
from the Yamaha device (1-16, 17-32, 33-48, and/or 49-64) in any combination. 

Select which mic preamps to control by clicking the check boxes.  

P  Note: When controlling remote preamps with m-control, remember that the Control Group setting 
must match on both the sending and receiving devices. 
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ASI A-Net Systems Interface 
The ASI device window displays the available Pro16® A-Net outputs as four Zones, labeled A-D. The actual 
number of network Slots available to the four Pro16 Zones is based on the current network sample rate.  

The four Pro16 A-Net ports on the ASI 
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MH10/MH10f Merger Hubs
The MH10 (and MH10f) device window shows the device’s ten A-Net ports; any ports with an active Pro64 
device connected are displayed with a solid color green icon. (The displayed port LEDs are read-only)  

Pro64 A-Net ports on the MH10/MH10f
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6416dio Digital I/O Module
The 6416dio Device Overview provides radio buttons for choosing a clock source. The choices are Network 
(internal), Word Clock, and AES3.  

The 6416dio has radio buttons for selecting a clock source

If a clock error occurs (for example, if when using Word Clock, the clock source is disconnected) the 6416dio 
Clock Source radio buttons will display the error in red. (The network temporarily uses the internal clock 
until the external source becomes available.) Changing this setting will not have an effect on network 
clocking if this particular 6416dio device is not the Clock Master. 
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RCI Remote Control Interface
The RCI device window includes a selector for choosing an A-Net Slot to monitor through the RCI’s built-in 
headphone and line-level output. Click the up/down arrows to scroll through and select Slots from 1-64 or 
Mute. (The actual available Slots are based on the current network sample rate.) 

The RCI overview

A radio button in the RCI device overview chooses the RCI/MCS sync mode that determines how audio 
is routed to the RCI’s line-level and headphone monitor output. With MCS Sync On the RCI follows Slot 
selection on the MCS or from the software. When using MCS Sync Off the user controls the monitor Slot 
selection manually from the RCI front panel (or the RCI’s Device Window). When choosing this option,  
Slot selections from the MCS are ignored, allowing an important channel to remain in the monitors or 
headphones even while the engineer selects and makes changes to other Slots in the network. 
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Matrix Assignments 
When an input device is set to Matrixed (the default for an AllFrame device), the drop-down menu within 
the Inputs to Network view is used to set Slot assignments. Click the channel’s Slot column to reveal the 
drop-down menu and begin the selection process. 

The AllFrame Inputs to Network view displaying the Slot selection dialog.  

In the Slot number column, a double dash symbol (- -) indicates that the input channel is not assigned to a 
network Slot. The channel cannot be made active until a Slot assignment exists. 

To make a matrix assignment, click on the arrow symbol in the Slot column for the channel to reveal the 
menu of available Slots (the actual numbers seen here is dependant on the current sample rate). Any 
network Slots that are already active in the network are displayed with italic text. Slots that are active 
elsewhere in the network can be assigned to an input channel on the current device but cannot be 
activated until the Slot is deactivated on the other Pro64 device. Only one matrix assignment to a given 
Slot per device is possible.  Matrix assignments save with the project and can also be saved in Scenes and/
or Device Presets. 
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Clearing Matrix Assignments
To clear one input assignment, set the routing to None, a double dash, “- -”, will appear in the Slot column.  
To clear all of an input device’s matrix routings, use the Clear All Matrix Slot Assignments command 
found in the Channel Settings menu. This command will set each input’s Slot assignment column to read 
“- -” to indicate that no valid Slot assignments exist. Active Slots will automatically be deactivated and their 
network resources available to other Pro64 deices.  

Rest all matrix assignments with one command. 
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Device Window Views 
In addition to the Device Overview features described above, most device windows have a View menu 
used to open and close the various views provided for the device. The options include:

•	 Device Overview  (all devices) 

•	 Inputs to Network  (AllFrame, 6416i, 6416m, 6416Y2, and 6416dio)

•	 Outputs From Network  (AllFrame, 6416o, 6416Y2, 6416dio, and ASI)

Inputs and Outputs  (AllFrame, 6416Y2 and 6416dio)•	

•	 Device Presets  (AllFrame, 6416i, 6416m, 6416Y2, 6416o, 6416dio, and ASI)

•	 Port Names  (MH10/MH10f only) 

The RCI device window does not require a View menu; all information is displayed in the overview. 

Inputs to Network View 
The AllFrame, 6416i, 6416m, 6416Y2, and 6416dio share a common set of controls for managing inputs 
to the network. To open this view, choose Inputs to Network from the View menu. The view will open, 
showing the available inputs and channel strip parameters for mic preamps (if applicable). 

The Inputs to Network view   

The first four columns of data displayed are common to all five devices. The Ch column corresponds to 
the input channels on the Pro64 device; this is a read-only field. The Active column mirrors the channel 
grid seen in the device overview. To toggle a setting click a channel’s Active box from either location. The 
Active box will light green if the channel is active on the network. 

Text in the Channel Name field is user-defined. Click to edit the text; there is a 16-character maximum. 
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Text entered in this field is stored in the Pro64 device itself and is available throughout the network to all 
output-capable devices. Use the Edit menu’s copy/paste commands as needed on user-defined text. 

The Slot column shows the network Slot to which an input module’s channel is assigned. The text in this 
column is read-only when an input device is set to one of the four 16-channel input ranges. It is displayed 
as a drop-down menu when the matrix is active (this is the default view for AllFrame devices). 

Stereo Links 
To set a pair of input module channels to be stereo linked from Pro64 Network Manager, they need to 
follow the Pro64 network rules: the channels must be an odd-even pair and both channels must be active 
in the network. 

Linking/Unlinking Channel Pairs
To link a pair of active channels, right-click in the Active column for either of the channels. In the menu, 
that appears choose Stereo Link On. To unlink a pair of channels right-click in the Active column for either 
of the channels and choose Stereo Link Off or deactivate one of the active Slots. 

The 6416Y2 card is an exception—its stereo links are set manually using the DIP switches on its front panel. 
No software control of the link on/off function is available.  

The stereo link menu 

For channels that are set as stereo pairs on an input module, a special bracket icon will appear in the Inputs 
to Network panel. 
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Stereo links are set on channels 3–4 and 11–12.  

Mic Preamp Channel Settings
In addition to the input settings common to all Pro64 input devices, the Inputs to Network view for the  
AllFrame and 6416m display the channel strip parameters for the mic preamps: Mute, Gain, Phase, Low Cut 
filter, -24dB Pad, and +48V Phantom Power. 

6416m channel strip settings in the input view  

Click any button in the channel strip to toggle its status; to change mic preamp gain click the up/down 
arrows on screen or click in the numeric Gain field to edit gain values with the keyboard arrow keys or with 
text entry. 
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The 24dB Pad and +48V Phantom Power will require confirmation via a dialog box in Pro64 Network 
Manager. Click Yes to apply the change or No to cancel. 

 

Confirmation is required for changes to +48V and Pad settings. 

Any updates to mic preamp channel strip settings made from other controllers in the network (such as an 
RCI/MCS combination or a Yamaha device with a Pro64 A-Net card installed) will automatically update the 
on-screen settings. 

Clearing Channel Settings
Two convenient functions are found in the Channel Settings menu that can simplify the editing of 6416m 
mic preamp parameters. Use the Clear Channel Settings command on a selected channel to reset a single 
preamp channel to the defaults. Or use the Clear All Channel Settings command to reset all 16 preamp 
channel strips at once. It is not necessary to select channels first when using this command. 

Both Clear Channels settings commands require confirmation. Save a Device Preset before clearing the 
channel settings if you need to recall the current preamp settings at a later time. 

Outputs From Network View 
The AllFrame, 6416o, 6416Y2, and 6416dio each contain an Outputs from Network view that shows details 
about the active network Slots assigned to their outputs. The ASI A-Net System Interface also has an 
Outputs from Network view, but offers features designed to simplify routing Pro64 Slots to Pro16 devices 
such as A-16II Personal Mixers.  See page 106. 

As with an input device, the Ch column is related to the physical output channels available from the Pro64 
device and is a read-only field. An AllFrame device shows the I/O card’s installed location as well as the 
channel number on that card (displayed as A1-A4, B1-B4, etc.).  

The Active column has yellow indicators that work as on/off switches for the audio assigned to the device’s 
channels. Click any switch to toggle its state (see the exceptions starting on page 108 for the 6416Y2 card 
and ASI). Since the outputs from a Pro64 device do not alter the makeup of the Pro64 network’s inputs, no 
confirmation dialogs are required; output channel status can be changed at any time. 
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The Outputs from Network view for a 6416o 

The Slot field shows the network Slot currently assigned to each of the output channels on the device. 
Slot numbers seen here are directly related to the Slot range currently assigned in the Outputs grid of the 
device overview (Slots 1-16, 17-32, 33-48, 49-64 or Matrixed). Slot numbers are read-only until the device is 
set to Matrixed using the Slot range pop-up in the overview. 

The read-only Channel Name and Device fields are also related to the device’s currently selected output Slot 
range and will display each output channel’s source name and its originating network device, updating 
immediately as changes are made in the network. Note that the Channel Name and Device field text will 
read “No Active Input” for channels that do not have an active Slot assigned somewhere in the network. 
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Setting an Output Matrix Assignment 
For all non-AllFrame devices the first step in assigning a matrix output assignment is setting the output 
device to use the matrix. In the Slot range drop-down menu in the Device Overview, choose Matrixed 
from the menu, then click Yes in the confirmation dialog box that appears. . 

Setting an output device to Matrixed requires confirmation.  

In the Outputs from Network view, the individual channel rows change to reveal a drop-down menu per 
channel. Unassigned channels read as No Active Input. Use the dialog box to select an output from the 
available sources active in the network. The sources are sorted in Slot order; the actual number of Slots 
available in this menu is determined by the current sample rate. Any number of outputs on a Pro64 device 
can be assigned to output the same network Slot. Matrix assignments save with the project and also with 
Scenes and Device Presets.   
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Select an output source from the menu to assign it.  

Direct Text Entry
Another way to assign a matrix output Slot on a Pro64 device is via direct text entry. Once an output device 
is assigned to the matrix, clicking the Slot number in the Outputs From Network view will highlight its text. 
To change the routing assignment, type a new number on the keyboard. Optionally, use the keyboard’s 
up/down arrow keys to scroll through all network Slots. Press the keyboard Enter key when finished to 
accept the change. 

Type a new Slot assignment or scroll with the arrow keys to make a change.    
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Matrix Assignments on the ASI
The ASI A-Net Systems Interface allows Pro16 output devices such as the A-16II Personal Mixer to be 
connected to a Pro64 network. The ASI has four Pro16 outputs, labeled on the hardware in blocks of 
sixteen channels as 1-16, 17-32, 33-48, and 49-64. In its standard configuration, the ASI outputs the 64 Slots 
of a Pro64 network (at 44.1/48kHz) in sequential order. Adding matrix assignments to the ASI makes this 
device even more powerful.  

ABC
Zone: 

D

The ASI front and rear panel interface s

Within the Pro64 Network Manager interface the four Pro16 outputs of the ASI are referred to as Zones; 
the Zones are labeled A, B, C, and D. With the addition of matrix assignments the Pro16 outputs no longer 
need to be restricted to sequential blocks of 16 channels. Each ASI in the network can create four unique 
sets of outputs channels for on-stage monitoring with A-16II Personal Mixers using any Slots in the Pro64 
network. Any number of ASI devices can be added to a Pro64 network to provide an unlimited number of 
custom programmable multi-zone monitor mix feeds.  

Two Zones of the ASI are shown with matrix assignments. 

P  Note:  The outputs on an ASI cannot be turned off. 
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ASI Outputs

In Pro64 Network Manager the ASI defaults to having its four Pro16 outputs assigned in blocks of 16 
channels. Zone A is automatically assigned to Slots 1-16, Zone B is assigned to Slots 17-32, Zone C is assigned 
to 33-48, and Zone D is assigned to 49-64. Changes can be made by opening the ASI Device Window. 

The default state for the ASI has all Zones set to four sequential blocks of 16 channels each. 

To access the matrix functionality on the ASI, click the box marked Manage Slot Assignments in the Device 
Window overview. Once checked, the Slot assignment drop-down menus in the overview become active. 
Each Zone can be assigned to one of five choices: 

•	 Slot 1-16 
•	 Slot 17-32  
•	 Slot 33-48 
•	 Slot 49-64 

Matrixed •	

To change the routing for a Zone, select one of the options and confirm the change by clicking Yes in the 
dialog box that appears. Click No in the dialog box to cancel the operation. 
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The default state for the ASI has all Zones set to sequential blocks of 16 channels each. 

To return to the ASI to its original state, with its outputs assigned in order from 1-64 across the four Pro16 
outputs, un-check the Manage Slot Assignments check box in the Device Window. In the dialog box that 
appears, click OK to complete the change. Click Cancel in the dialog box to leave the ASI in its managed 
state.

Clicking OK will reset the ASI to its default state. 
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ASI Matrix Views 

The Outputs From Network view for the ASI shows two of the available Zones at all times. Each set of 16 
outputs is labeled Pro16 Outputs rather than Outputs From Network as seen on Pro64 output devices. 
Any of the four Zones can be shown by selecting a Zone name from the drop-down menu found at the top 
of each Pro16 Outputs section. 

Two zones of Pro16 outputs are shown in each ASI Device Window. Select a Zone to view using the drop-down menu.  

Changing the content sent to any channel in a Zone follows the same rules as outlined previously for Pro64 
output devices. Click on the arrow in any channel’s row and choose the Pro64 Slot to be output. Optionally, 
select the Slot number to highlight it and then type in the desired Slot number. Save frequently used Pro16 
output assignments as Device Presets for easy recall. 
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Clearing Output Matrix Assignments 

Output assignments can be cleared for any output-capable device that has been set to Matrixed. Choose 
Clear All Output Matrix Assignments from the Channel Settings menu, and click Yes in the dialog box that 
appears. All output channels are set to no assignment, displayed as “- -” in the Slot column of the Outputs 
from Network view.  

Matrix assignments are shown before and after being cleared. 
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6416Y2 Card and ASI Outputs
In its Device Window, the individual outputs from a 6416Y2 A-Net card cannot be turned off—the card 
does not have DIP switches on the circuit board that can support this functionality. Outputs from the 
6416Y2 are always sent to the Yamaha console, where they can be routed to mixer faders as needed and 
turned on or off from the Yamaha console’s user interface. Clicking the activation icons for a 6416Y2 card 
output will cause a warning dialog box to appear as a reminder.  

6416Y2 outputs are always active.  

The same rules apply for the ASI A-Net Systems Interface—the ASI has outputs that cannot be turned off. 
Clicking an output’s Active button in an ASI Device Window will result in a warning message. 
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The Inputs and Outputs View 

The bidirectional AllFrame, 6416Y2 A-Net Interface Card and 6416dio Digital I/O Module each have a view 
that opens the Inputs to Network and Outputs from Network panels together. Select Inputs and Outputs 
from the View menu to open it. The state of this window will save with the Project. 

The Inputs and Outputs view for the 6416Y2 card 
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Device Presets

Device Presets provide a simple way to save and recall settings for an individual Pro64 I/O device. Device 
Presets can be used to recall frequently used channel combinations, input channel names, matrix routings, 
etc. Note that Device Presets are not available on the MH10/MH10f, RCI, and ASI.

Device Presets are saved as part of a project; you will be prompted to create a project first if you attempt to 
create a preset when no project exists. 

Device Presets are saved with a project. 

A Device Preset stores the following information:  

Input and/or Output •	 Slot range  (1-16, 17-32, 33-48, or 49-64) 

•	 Matrix on/off state 

Matrix channel/Slot routing  •	

Active Input channels assigned to network Slots for AllFrame, 6416i, 6416m, 6416Y2, •	
and 6416dio 

•	 Channel names for input devices for AllFrame, 6416i, 6416m, 6416Y2, and 6416dio

Stereo Link status  (input devices only)  •	

6416m and AllFrame •	 mic preamp parameters:  Mute, Gain, Phase, Low Cut, Pad, and 
+48V phantom power 

Output •	 channel on/off status for AllFrame, 6416o and 6416dio 

P Note: Since the AllFrame hardware is user-configurable, it is important to understand that AllFrame 
Device Presets are linked to the specific configuration, type, and location of all I/O cards installed 
in the device. Moving or changing the quantities of the I/O cards in an AllFrame will cause saved 
device presets in a project to become invalid. 
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The Device Presets View
To display the Device Presets interface choose Device Presets (Show All) from the View menu. By default, 
when the Device Presets are displayed all input and/or output panels for the current device will be shown. 
To hide the Device Presets, select any other view from the View menu. Undefined presets are marked as 
 - Empty - in the presets list.  

The Device Presets panel, shown in the 6416m device window 

Saving a Device Preset 
Up to 16 Device Presets can be saved per Pro64 I/O device. The presets are stored to disk along with other 
Pro64 Network Manager project settings. To save a Device Preset into one of the 16 locations, first configure 
the Pro64 device as required for your application. Next, click in one of the Device Preset locations until the 
text cursor appears. Give the Device Preset a name, up to 16 characters, and then click the Save button in 
the Device Preset panel or press the Enter key on your keyboard. Confirm the save operation in the dialog 
box that appears. 

Confirm the save operation. 

To use the default name for a preset, select a preset location and then click the Save button without typing 
in a preset name. The name will be filled in automatically (Preset 01, Preset 02, etc.) Presets can be renamed 
later as needed, see Updating a Device Preset below.  
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Updating a Device Preset 
Once a Device Preset has been saved you can change its settings, rename it, and update it as often as 
needed. To update one of the 16 Device Presets with a newer version, select the preset in the Device Preset 
panel to highlight it, rename it if necessary, and then click the Save button in the Device Preset panel. You 
will be prompted to confirm the change before the preset is overwritten. 

Confirm the change to an existing preset. 

To change only the preset’s name, click the preset’s name field, select and enter any text to be changed, 
then press the keyboard Enter key. Confirm the update in the dialog box that appears by clicking Yes. 

Recalling a Device Preset 
To recall a Device Preset that has been saved with the project, first select the preset to highlight it and then 
click the Recall button in the Device Preset panel. 

For input modules, if there are any Slot activation conflicts caused by the Device Preset recall, a warning 
dialog will alert you to the conflict. 

Conflict warning 

Remember that only one input channel can occupy a network Slot at a time. 

Clearing a Device Preset 
To remove a Device Preset from the preset panel (which also removes it from the project and from disk), 
first select the preset to highlight it and then click the Clear button in the Device Preset panel.

Clearing a preset requires confirmation. 

Confirm the operation by clicking the Yes button. There is no undo. for this action 
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Device Window Menus 
Each Device Window has a set of menus along its top edge. The File and Edit menus are common to all 
Device Windows. Device-specific menu commands are noted below. 

File Menu
The File menu contains the following commands: 

Print Device Info... Prints a report detailing the current device’s settings 

Print Preview Displays a preview of the information that will be printed in the Device 
Info report

Close Window Closes the current Device Window  (shortcut - Ctrl+W) 

Edit Menu
The Edit menu contains these text editing commands: 

Cut Cuts the selected text  (shortcut - Ctrl+X) 

Copy Copies the selected text to the clipboard  (shortcut - Ctrl+C) 

Paste Pastes text that was copied to the clipboard  (shortcut - Ctrl+V) 

Clear Text Clears the selected text  (shortcut - Del key)

Undo Undoes the last cut, clear, or paste operation  (shortcut - Ctrl+Z)
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View Menu

Use the View menu to select a view for the currently selected Device Window. Not all views are available 
for every Pro64 device. Only one view of a device is available at a time. 

Device Overview Available for all devices; the most compact view  

Inputs to Network AllFrame, 6416i, 6416m, 6416dio, and 6416Y2 only 

Outputs From Network AllFrame, ASI, 6416o, 6416dio, and 6416Y2 only 

Inputs and Outputs AllFrame, 6416dio and 6416Y2 only 

Device Presets (Show All) AllFrame, ASI, 6416i, 6416o, 6416m, 6416dio, and 6416Y2 only

Port Names MH10/MH10f only 

Tools Menu
Lock or unlock the front panel of Pro64 I/O modules (6416i, 6416m, 6416dio, and 6416o only) using the 
commands in the Tools menu. 

Lock Front Panel Prevents front-panel editing for the selected I/O device. A lock icon 
will appear in the device’s status bar. 

Unlock Front Panel Allows front-panel editing for the selected I/O device.  

Card Configuration 6416Y2 card only – opens the Card Configuration dialog box where 
m-control, Serial Interface, and Pad mode settings can be changed. 
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Channel Settings Menu – Input Devices 

The Channel Settings menu is available for I/O modules only (AllFrame, 6416i, 6416m, 6416Y2, 6416dio, and 
6416o) and contains the commands listed below.  

Input Module Settings  (AllFrame, 6416i, 6416m, 6416Y2, and 6416dio)

Activate Input Channel Makes the selected channel active in the network and lights its 
green ‘Active’ LED. 

Activate All Input 
Channels

Sets all channels of the current device as active in the network and 
lights their green ‘Active’ LEDs.

Deactivate Input 
Channel

Deactivates the selected channel, removing it from the network, 
and turns off its green ‘Active’ LED.

Deactivate All Input 
Channels

Deactivates all channels on the device, removing them from the 
network, and turns off all green ‘Active’ LEDs.

Stereo Link On Activates a stereo link for a pair of adjacent channels.  

Stereo Link Off Clears the Stereo Link for the selected channels. 

Clear Input Channel 
Name

Clears text from the Channel Name field. 

Clear All Input Channel 
Names

Clears text from the Channel Name field of all 16 channels.

Clear Channel Settings AllFrame and 6416m only;  clears the channel strip parameters 
(Mute, Gain, Phase, Low Cut, Pad, +48V) for the selected channel. 

Clear All Channel 
Settings

AllFrame and 6416m only;  clears all channel strip parameters (Mute, 
Gain, Phase, Low Cut, Pad, +48V).  

Clear All Input Matrix 
Slot Assignments 

Resets an input device to the default routings. 

P Note  	Activating one or more input channels on a Pro64 input module is subject to all Auto Mode 
network rules. Attempting to activate an input module’s channel into a network Slot that is 
already in use by another input device will result in an error message.  
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Channel Settings Menu – Output Devices 

Output Module Settings  (AllFrame, 6416dio, and 6416o)

Activate Output 
Channel

Makes the selected output channel active and lights its yellow 
‘Active’ LED.  (Not available on ASI or 6416Y2 cards)

Activate All Output 
Channels

Sets all output channels of the current device to active and lights 
their yellow ‘Active’ LEDs.  (Not available on ASI or 6416Y2 cards)

Deactivate Output 
Channel

Deactivates the selected output channel and turns off its yellow 
‘Active’ LED.  (Not available on ASI or 6416Y2 cards)

Deactivate All Output 
Channels

Deactivates all output channels on the device and turns off all 
yellow ‘Active’ LEDs.  (Not available on ASI or 6416Y2 cards)

Clear All Output Matrix 
Slot Assignments 

Resets an output device to the default routings. 

Presets Menu 
The Presets menu is available for I/O devices only (AllFrame, ASI, 6416i, 6416m, 6416Y2, 6416dio, and 6416o) 
and contains the following commands: 

Save Device Preset Saves the current state of the Pro64 I/O device as a preset in the 
selected location (1-16); also used when updating existing presets.  

Recall Device Preset Recalls the currently selected preset for the device. 

Clear Device Preset Clears the currently selected preset and removes it from disk.  
There is no undo. 

Clear All Device Presets Clears all 16 presets and removes them from disk. There is no undo. 
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Audio Slot Manager 
The Audio Slot Manager allows the user to view the I/O routings for an entire Pro64 network from a central 
location, which is especially useful when a network has a large number of Pro64 I/O devices. 

Use the Audio Slot Manager inspect any network Slot and get an easy-to-use overview of the Pro64 devices 
that have input and/or output assignments to the selected Slot. Two views are available: Slot Assignments 
and Slots and I/O Routing.  Use the window’s View menu to choose a view. 

 v

w x y z








Audio Slot Manager Components  

Audio Slot Manager Components 

1 Slot Assignments View

2 Input and Output Routing View

3 Slot numbers 1-64

4 Pro64 device supplying the input

5 Channel number on the source input device

6 Channel Name, from the source device 

7 Inputs in the network assigned to the selected Slot

8 Active LED 

9 Network outputs using the selected Slot

10 Scroll bars
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Slot Assignments View 
The Slot Assignments view shows the 64 network Slots as scrolling list. Information about the network’s 
Slots is displayed in columns.  The Slot column shows the network Slots (maximum 64 Slots at 44.1/48kHz) 
by number. Scroll the list with the scroll bar handles on the right side of the window. The Device column 
shows which Pro64 device is providing the input for each Slot (for example 6416m #1). The column marked 
Ch shows which input channel on that device is supplying the input to the network. The Channel Name 
column displays the user-entered channel name that was entered in the Device Window.  A Slot with no 
assignment is shown blank. Click any row to select a Slot. 

The Audio Slot Manager window displays all network resources as a list.  

Information is this part of the window is read-only. Changes made to network Slot assignments or channel 
names from individual Device Windows or from the Slots and I/O Routing view of the Audio Slot Manager 
are instantly updated. 
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Slots and I/O Routing View 
The default view for the Audio Slot Manager window shows both the Slot Assignments and the Slots and 
I/O Routing view. On the right side of the window, the routing for the selected Slot is divided into two 
sections,  marked Inputs Assigned to Slot x and Outputs Using Slot x (where x is the Slot that was selected 
in the left side of the window, the Slot Assignments View).  

The left side of the Slots and I/O Routing shows the network devices that have inputs assigned to the 
selected Slot and indicates which input is active with a green LED icon in its Active column. (Only one 
input can be active per network Slot.) To change the assignment to another device in the list, first disable 
the currently active device’s input by clicking the green LED in its Active column. Then click the Active 
LED on a different device to assign it to the selected Slot. If the device you’d like to assign the Slot to is not 
displayed, open its Device Window from the Network Overview and make the assignment to the desired 
Slot there first. It will be added to the list of available inputs in the Slots and Routing view. 

The Slots and I/O Routing view  

The right side of the Slots and I/O Routing sections shows network devices that have an output assigned 
to use the selected input source. Any number of output devices can be assigned to use a network Slot, 
including multiple channels on the same device. Outputs that are active are indicated with a yellow LED in 
the Active column. 
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Scene Manager 
Within a project, Pro64 Network Manager can also save and recall complete network configurations in the 
form of a Scene, which can simplify I/O management of a Pro64 network. Up to 99 Scenes can be stored 
per project. Each configuration can be recalled quickly without the need to shut down the Pro64 Network 
Manager application, close the current project, or configure front-panel settings on I/O modules.   

To open the Scene Manager window choose Scene Manager from the Windows menu of the main 
workspace or use the keyboard shortcut Ctrl+2. 

Scenes are an optional component of a Pro64 Network Manager project; there is no requirement to use 
Scenes once a project has been saved.   

Information saved in a Scene includes:  

Type and quantity of all Pro64 •	 devices in the network 
•	 Active Slots on all I/O devices 

Slot routing and •	 matrix settings 
Active •	 Virtual Data Cables 
Channel names on all input devices•	
User-created text, labels, •	 comments, etc. 
Scene notes•	
6416dio and AllFrame clock source •	

   
Scenes do not save the following network-wide settings (these are saved in the project, except as noted): 

•	 Sample Rate
•	 Control Master device 
•	 Clock Master device
•	 Device Numeric ID and Location labels
•	 Port names for MH10 and MH10f  
•	 Device Presets (managed individually for each I/O device) 

P Note:  The Scene Manager relies on the folder structure created by the project to manage its Scenes.  
Do not move or rearrange the project’s sub-folders or their contents. 

How Scenes Work 
Scenes are designed to simplify the management and recall of network configurations and should not 
be confused with scenes as used in the context of a mixing console or digital audio workstation (DAW).  
Scenes are not intended to provide seamless transitions between network configurations. The time it takes 
for a Scene to load will vary, based on a variety of factors including the total number of Pro64 devices in 
use, the makeup of the network, and the cable distance between Pro64 devices for all Cat-5e and/or fiber 
optic cabling in the network. 

P Note:  Network outputs will mute briefly while Scenes are recalled as resources are reallocated to avoid 
noise or abrupt changes in level. This is normal behavior.  
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The Scene Manager Window 
Components of the Scene Manager window are described below. 

 v w x y

z

 

 Number (No.) column for Scenes 1-99; sortable 

v Locked Scenes are indicated with a lock icon.  

w Scene Name; 16 characters maximum; sortable   

x
Scene Valid indicates Scenes that are compatible with the current 
network hardware configuration with an OK icon. Incompatible 
Scenes show a red exclamation point ! symbol. 

y Scene Notes; user-defined text, up to 256 characters  

z Save, Recall, and Clear buttons for Scene operations 
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Scene Manager Features
The Scene Manager window consists of the Number, Lock, Scene Name, Scene Valid, and Scene Notes 
columns along with the window’s menu bar and the Save, Recall, and Clear buttons. 

Number Column
The Number column (abbreviated No.) lists the Scenes from 1-99. Sort the list by number by clicking in the 
column header. Scroll the window to see more Scenes. 

Lock Column
When a Scene is locked, a lock icon is added to the column. 

Scene Name Column
The Scene Name field holds user-created text, up to 16 characters per Scene. Sort the list by name by 
clicking in the column header. 

Scene Valid Column
The Scene Valid column indicates Scenes that are usable within the current project with a green OK icon. 
If for any reason a Scene is missing or not compatible with the current project, a red exclamation point ( ! ) 
will be displayed. Incompatible Scenes can not be loaded or edited. 

Valid Scenes have a green OK icon; incompatible Scenes have a red exclamation point. 

Scene Notes Column 
The Scene Notes column holds user-created text, up to 256 characters per Scene. 
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Saving a Scene
Scenes are saved to disk within the Project Scenes folder found inside the project folder once a project 
has been saved. Scenes can be stored in any of the 99 locations in any order; available Scene locations are 
marked – Empty – in the Scene Name column.

Clicking in an empty Scene field allows you to enter a name for the Scene. 

To save a Scene, place the cursor in the Scene Name field of an empty Scene location. Once the cursor 
changes to the text entry tool, type in a name for the new Scene (16 characters maximum). Press the Enter 
key on the PC keyboard. 

Click Save to store the Scene. 

Confirm the save operation in the dialog box that appears by clicking OK; the Scene is stored to disk and 
is ready to use. Clicking No in the Save dialog box will exit and cancel the save operation. To save a Scene 
and use the default name (Scene 01, Scene 02, etc.), select an empty Scene row and then click the Save 
button or choose Save Scene from the Scene menu. Confirm the save operation by clicking OK.   

Adding Scene Notes
Use the Scene Notes field to store text information related to a Scene. Up to 256 characters can be entered. 
Once a Scene has been saved, you can enter Scene Notes text at any time. Text can be added to the Scene 
file without requiring the Scene to be re-saved, allowing you to add and edit notes for multiple Scenes 
without requiring them to be recalled first. Scene Note text is saved with the project.  

To edit existing note text, click in the Scene Notes field for a Scene. When the text cursor appears, select all 
or part of the current text to change or delete. Use the Edit menu’s Cut, Copy, and/or Paste commands as 
needed. Press the keyboard Enter key or click in another Scene row to complete the edit. The text is added 
to the Scene file without requiring the Scene to be re-saved. Scenes Notes cannot be added or edited if a 
Scene is locked. Remember to save the project after editing Scene Notes. 

Use the Escape (Esc) key on the keyboard to exit the text entry mode without changing the existing text.  

Renaming a Scene
Unlocked Scenes can be renamed at any time while a project is open. To change a Scene’s name, click in 
the Scene Name field for the selected Scene. When the text cursor appears, change the name as needed. 
Press the keyboard Enter key and then confirm the edit (click Yes) to complete the operation. The Scene 
name is changed and the Scene file is updated on disk; you do not need to re-save the Scene with the Save 
button to rename a Scene. Save the project after editing Scene names. 
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You can also use the Edit menu’s Cut, Copy, and/or Paste commands during renaming. Use the Escape (Esc) 
key on the keyboard to exit the text entry mode without changing the existing Scene name text.  

Recalling a Scene
Once Scenes are saved to disk with a project they can be recalled as needed. To recall a Scene, click 
anywhere in the row of a valid Scene to select it; the row will be highlighted. Click the Recall button in the 
Scene Manager window or choose Recall Scene from the Scene menu to recall the Scene. 

Select a Scene and click Recall. 

P Note:  Remember that audio will mute briefly while the network is reconfigured. 

The time it takes to recall a Scene and reconfigure the network will vary and is based on the number of 
Pro64 devices, the distance between devices, and the device’s relative location to the Control Master. 

Making Changes to Existing Scenes
To edit and update an unlocked Scene that has already been saved, first make any changes to the Pro64 
devices in the network that are required including I/O routing, channel names, Slot ranges, etc. Then 
select the Scene to be updated by clicking the appropriate row of the Scene Manager; the row will be 
highlighted. Click the Save button and then confirm the overwrite message in the dialog box that appears. 
The new configuration is stored to disk. 

Clicking the No button in the dialog box will cancel to update operation and return you to the Scene 
Manager window. 

P Note:  Only unlocked Scenes can be updated.

Locking a Scene
To prevent changes from being made to a Scene, use the lock function. Locking a Scene prevents changes 
from being made to the Scene’s contents, the Scene Name and Scene Notes fields, and also prevents the 
Scene from being deleted from disk when using any of the Clear commands. Locking a scene will not 
prevent it from being recalled. 
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Lock a Scene by right-clicking in Scene row. 

To lock a Scene, click a Scene row to highlight it. Right-click in the row to open the contextual menu. 
Choose Lock Scene from the menu that appears. A lock icon is added to the row. As an option, choose Lock 
Scene from the Scene Manager window’s Scene menu. 

To unlock a Scene, right-click on a selected Scene’s Lock column and choose Unlock Scene from the 
contextual menu or choose Unlock Scene from the window’s Scene menu. 

Locking All Scenes

To lock all the Scenes in a project, use the Lock All Scenes command found in the Scene menu as well as in  
the contextual menu. All Scenes will have the lock icon added to their rows. To unlock all currently locked 
Scenes use the Unlock All Scenes command. All Scenes are returned to their edit-ready state. 

Empty Scenes cannot be locked. 

Clearing Scenes
To remove one or more Scenes from a project, use the Clear command. First click a Scene row to highlight 
it. Click the Clear button and confirm the operation in the dialog box that appears by clicking Yes. The 
Scene file is removed from disk and the Scene row is retuned to the default settings. Clicking No in the 
dialog box will cancel the clear operation. 

Remove a Scene from the project with the Clear button. 

As an alternative, choose the Clear Scene command from the Scene Manager window’s Scene menu. There 
is no undo. 
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Use the commands in the Scene menu to delete Scenes from a project. 

To clear all the Scenes in a project use the Clear All Scenes command found in the Scene menu. In the 
dialog box that appears click Yes to permanently erase all Scene files from disk and remove them from the 
project or click No to return to the Scene Manager window without deleting any of the Scene files. There is 
no undo possible when deleting all Scenes. Save the project after editing and clearing Scenes. 

Scene Compatibility
To be used online with a Pro64 Network Manager project, a Scene needs to contain information that is 
compatible with the exact quantity and type of all Pro64 devices in the network. Changing the number 
of Pro64 devices in the network, for example from two 6416m to three 6416m mic preamps, will cause 
any Scenes created when only two 6416m preamps were in the network to be invalid when three 6416m 
preamps are connected. AllFrame I/O cards must be in the same slot (A-F) as when the Scene was saved in 
order to be valid. 

Working Online 
When a project is loaded while working online, every Scene in the project file is checked for compatibility. 
If the Scene is compatible it is marked in the Scene Valid column of the Scene Manager window with a 
green OK icon. This icon indicates that the Scene can be loaded into the current hardware configuration.

If a Scene is found to be incompatible it will be marked with a red exclamation point icon (!) in the Scene 
Valid column. Scenes can become invalid for a number of reasons including a change in the makeup of 
the network (a Pro64 device is not powered up, for example), a Scene being renamed or moved from the 
project folder, or a cable problem causing A-Net communication between devices to change or become 
intermittent. 

Working Offline 
When working offline, Scenes can be edited as needed; new Scenes can also be created without requiring 
a network connection. Scenes are only checked for compatibility when the network transitions from 
working offline to working online. As happens when a project is opened while already online, all valid 
Scenes are marked OK and any invalid Scenes will show (!) in the Scene Valid column. 
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Valid scenes are marked in green, invalid ones in red.  

Scenes in an online network that start out as valid will become invalid if a new Pro64 device is added to (or 
removed from) the network after the Scenes have been saved because the device count has changed. 

Validating Scenes 
There are two utility commands for checking Scenes within a project. Choose the Validate Scene Settings 
command to re-scan a single selected Scene for compatibility with the current network or choose Validate 
All Scene Settings to check all Scenes in the project. Any Scene whose compatibility has changed will have 
its status in the Scene Valid column updated 

Validate Scene commands in the Scene menu
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Scene Manager Menus 
The Scene Manager menu commands are described below; they are also available by right-clicking in the 
Scene Manager window. 

File Menu
The File menu contains the following command: 

Close Window Closes the Scene Manager window  (shortcut - Ctrl+W) 

Edit Menu
The Edit menu contains the text editing commands described below. Note that the Edit menu’s text editing 
commands only apply while actively editing text in the Scene Name and Scene Notes fields. 

Undo Undoes the last text-based cut, clear, or paste operation    
(shortcut - Ctrl+Z)

Redo Resets text to the last cut, clear, or paste operation  (shortcut - 
Ctrl+Shift+Z)

Cut Cuts the selected text  (shortcut - Ctrl+X) 

Copy Copies the selected text to the clipboard  (shortcut - Ctrl+C) 

Paste Pastes text that was copied to the clipboard  (shortcut - Ctrl+V) 

Clear Clears the selected text  (shortcut - Del key)
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Scene Menu

The Scene menu contains the commands used to manage a project’s Scenes. 

Save Scene Saves a Scene in the currently selected location   

Recall Scene Recalls the currently selected Scene  

Clear Scene Clears the currently selected Scene, erasing the file from the project 
and the hard disk; there is no undo.  

Clear All Scenes Clears all Scenes, erasing the files from the project and the hard 
disk; there is no undo. 

Validate Scene Settings Check the currently selected Scene to verify that it is compatible 
with the current network configuration 

Validate All Scene 
Settings

Checks all Scenes in the project to verify that they are compatible 
with the current network configuration

Lock Scene Locks the currently selected Scene 

Lock All Scenes Locks all Scenes without requiring that they be selected first

Unlock Scene Unlocks the currently selected Scene 

Unlock All Scenes Unlocks all Scenes without requiring that they be selected first



130 Pro64 Network Manager User Guide

Virtual Data Cable Monitor 
A Pro64 Network Manager project saves the configuration of all Virtual Data Cables (VDC) active in the 
network as part of a project. You can also use Scenes to recall different combinations of VDC assignments 
from within a single project if required. 

The read-only Virtual Data Cable Monitor window provides an overview of the 14 available VDC Slots. 
Making changes to VDC settings and routing must be done from the front panels of the Pro64 devices. 

To open the Virtual Data Cable Monitor window choose Virtual Data Cable Monitor from the Windows 
menu of the main workspace or use the keyboard shortcut Ctrl+3. Resize the window as needed; scroll 
bars appear automatically as the window is resized.  

The Virtual Data Cable Monitor Window 
Components of the Virtual Data Cable Monitor window are described below. 


v
w

x y

 

 VDC Slots; each of the 14 columns lists the settings for one of the 
Virtual Data Cables  

v VDC Type; shows the type of Virtual Data Cable input that is active 
on the source device

w VDC Source; the Pro64 device where the VDC input is connected    

x List of all VDC-compatible devices in the current network

y VDC destination; shows the type of Virtual Data Cable being 
output from the Pro64 device  
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VDC Slots 

The top row of the Virtual Data Cable Monitor window contains the 14 columns for the network’s VDC 
Slots. Each column contains the routing information for one of the Virtual Data Cables.  

VDC Type 
When a Virtual Data Cable is activated from a Pro64 device, information about the VDC will be displayed in 
the VDC Type column. Valid entries include GPIO, MIDI, and RS-232/422. 

An active VDC will show a yellow LED icon when only its input is activated. It will display a green LED icon 
when the input is connected to a valid output somewhere in the network. 

VDC 3 has an incomplete MIDI connection; VDC 8 shows a GPIO connection with two outputs. 

RS-232/422 VDC 

When using RS-232 or RS-422 with a VDC, remember that these data types require a pair of Virtual Data 
Cables per connection—one for transmit, the other for receive. An incomplete RS-232 or RS-422 VDC will 
have yellow LED icons in two columns. 

Yellow icons indicate that VDC 5-6 has an RS-232/422 input on 6416i #1 but no output device has been selected. 
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VDC Source

The VDC Source row indicates the Pro64 device in the network where the active VDC input is located. This 
row will be blank for a VDC Slot until a VDC becomes active. 

VDC Compatible Devices 
The Pro64 devices in your network that are capable of using Virtual Data Cables will be listed along the left 
side of the Virtual Data Cable Monitor window. Compatible devices in this list can include: 

•	 6416i Line-Level Input Module 
•	 6416m Mic Input Module 
•	 6416o Output Module 
•	 6416dio Digital I/O Module  
•	 6416Y2 A-Net Interface Card 

The AllFrame, ASI, RCI, MH10, and MH10f have no VDC ports and will not appear in this list, even if they are 
installed in the network. 

VDC Destination 
When an active VDC is being output from a Pro64 device, the output VDC will be shown in the VDC 
Destination row for each of the 14 VDC Slots. 

Three different types of VDC connections are shown. 

Note that multiple copies of GPIO and MIDI Virtual Data Cables can be output if required. RS-232 and RS-422 
are handshaking protocols; only one input device and one output device can be active per connection. 
The Pro64 network is capable of distributing a maximum of seven such transmit/receive connection pairs. 
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Event Log Window 
Pro64 Network Manager creates a log of application- and project-related events while you work. To open 
the Event Log window choose Event Log from the Windows menu of the main workspace or use the 
keyboard shortcut Ctrl+4. 

The Event Log window 

The Event Log window can be resized as needed and positioned anywhere within the workspace. 

Saving Event Log Text 
To save text from the Event Log window, select the desired region of text and use the copy and paste 
commands to save it in a standard word processor document window or email.    
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Troubleshooting 
The following section provides troubleshooting tips for the Pro64 Network Manager software.  

Problem Possible Solutions 

AllFrame – I/O card not recognized Update firmware on the F6 ��

AllFrame – no audio Check that the device is not in Standby Mode ��

Blue A-Net LED is blinking on some 
network devices’ front panels 

A blinking �� A-Net LED indicates a device whose 
firmware is out of date. 

Run the firmware update utility. ��

6416Y2 card – m-control is not 
working

The 6416Y2 card needs to be installed in �� MY expansion 
slot #1.

Check the m-control source—Rear Panel or ��
Backplane—in the Card Configuration window (found 
in the Tools menu of the 6416Y2 Device Window). 

Check that the network Slots to be remote controlled ��
are activated in the Card Configuration window  

A single card cannot be the network Control Master ��
and provide m-control.  Set a different Pro64 device or 
another 6416Y2 card as Control Master. 

Check front panel �� DIP switch #10 on the 6416Y2; it 
should be down to activate m-control.  

6416Y2 card – only 8 channels 
available at 44.1/48kHz

Check SW8, switch #10. Set it to up for 16-channel ��
operation and down for 8-channel. 

For the �� PM1D, this is normal. 

6416Y2 card – the Status icon is yellow 
instead of blue. 

Power down the Yamaha host device and remove the ��
6416Y2 card. Check SW9, DIP switch #10. It must be up 
for PC control. 

Network Overview – cannot see all the 
network’s devices

Check that device filtering is not active; choose �� Filter 
Settings... from the View menu and click the Reset 
button. 

Cannot update firmware on the 
Control Master device

Try temporarily using a different device as �� Control 
Master for the firmware update; return to the original 
configuration once the firmware has been successfully 
updated. 

Firmware updates fails or does not 
complete for a device 

Try moving the device closer to the Control Master, ��
keeping all cables as short as possible. 

Try a different �� USB-to-RS-232 adapter. 
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Problem Possible Solutions 

Pro64 Network Manager cannot 
communicate with the network

Check the  �� RS-232 cable and communication settings. 

Keep all RS-232 cables as short as possible. ��

Incorrect RS-232 �� baud rate settings

�� USB-to-RS-232 device is not set up properly 

Incorrect RS-232 cable; must be �� null modem and not a 
straight through cable

Check the pinout of the RS-232 null modem cable using ��
a multimeter.  

Pro64 Network Manager software is 
unstable or will not launch 

Check that the computer is running the proper version ��
of the Windows OS—Windows XP with Service Pack 3 
or Windows 7

Check that the computer has the correct Microsoft �� .NET 
Framework 3.5 components installed (available on the 
Microsoft website). 

Run the ‘�� regedit’ utility and search for Net Framework 
Setup to find the versions installed on your PC. 
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Appendix

RS-232 Cables and Pinout  
Using an RS-232 device with a Pro64 device requires a female-to-female DB9 null modem cable (also 
referred to as a crossover cable). 

The RS-232 jack found in the VDC section of a Pro64 device has the following pinout.

  

1        2        3       4         5

6        7        8        9

DB9 connector pinout on a Pro64 device   

RS-232 Connections
The table below describes the pinout for the RS-232 connectors found on Pro64 devices. 

Pin   Signal 

1 Data Carrier Detect   * 

2 Received Data 

3 Transmitted Data 

4 Data Terminal Ready    *

5 Signal Ground 

6 Data Set Ready   * 

7 Request To Send    *

8 Clear To Send    *

9 Ring Indicator   *

 		  *  Not supported, no connect  
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Wiring a DB9 Crossover Cable
The following table can be used to create a null modem (crossover) cable:  

Crossover Cable

Pin # Pin # 

1 and 6 4

2 3

3 2

4 1 and 6

5 5

7 8

8 7

Pin 9 - no connect
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Index
Symbols
24dB Pad  99
+28dBu  79
48kHz  60
+48V  98, 99, 110, 115
49-64  67
96kHz

6416Y2 card  88
192kHz  60
6416dio Digital I/O Module  23, 55, 65, 92, 109, 114, 132

clock error  92
RS-422  23

6416i Line-Level Input Module  55, 114, 129, 132
6416m Mic Input Module  55, 69, 107, 114, 132

change gain  98
Clear Channel Settings  99

6416o Output Module  55, 132
6416Y2

Firmware Update  81
6416Y2 A-Net Interface Card  22, 56, 65, 68, 69, 81, 99, 

114, 132
96kHz  88
Card Configuration  87
Outputs From Network  109
stereo links  97

6416Y2 as a Slave Device  25
6416Y2 as Control Master  25
6416Y2 Card  23

channels 9-16 disabled  84
Control Master  81
DIP Switch  26
DIP switch control  27
firmware update  26
Front Panel DIP Switches  25
Managed Mode  27
Pro64 Network Manager enabled  27
Status Icon  81
Virtual Data Cable  83

6416Y2 card - 8 channels  134
6416Y2 Card Outputs  108
6416Y2 firmware update  35
6416Y2 outputs

yellow LED  85
6416Y2 Output Slots  85, 86
.NET Framework  6, 135
.nmp extension  39
.upd extension  12

A
A-16II Personal Mixer  103

Zones  103
About Pro64 Network Manager  51
activate a channel  67

Activate All Input Channels  115
Activate All Output Channels  116
Activate Input Channel  115
Activate LED Device Identify  54
Activate Output Channel  116
Activating Channels  67
Active column  96, 97, 99
Active LED  116, 117
Active Slot  120
active VDC  132
Adapter

RS-232  22
Adobe Reader  12, 51
AES3  85, 92
AES3 clock  4, 73, 78
AllFrame  2, 3, 21, 24, 56, 65, 69, 70, 96, 97, 109, 114

I/O card  70, 110
Mic level  79
mic preamp  98
Output Level Settings  80
Outputs  99
Slot range  67
Standby  75
Standby Mode  4, 54
Standby momentary switch  75
USB driver  12

AllFrame C4dio
sample rate converter  4

AllFrame compatibility  41
AllFrame I/O cards

Scene  126
AllFrame I/O Grid  66
AllFrame Multi-Modular I/O System  2
AllFrame Output Levels  79
Alt+F4  48
analog audio output

AllFrame  79
A-Net  76, 126
A-Net icon  52, 53

blue  82
yellow  54, 82

A-Net LED  134
A-Net Slot

monitor  93
A-Net status icon  65
Apple  6
application folders  12
ASI  114

Device Preset  106
Manage Slot Assignments  104
Matrix Assignments  103
Port names  120
Pro16 Zone  90
Zone  106
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ASI A-Net Systems Interface  56, 90, 108
ASI Matrix View  106
ASI Outputs  108
Assigning Input Channels

Matrix  68
Audio Clock Source  4
Audio Clock Source menu  72
audio output

mute  120, 124
Audio Slot Manager  14, 18, 117

Slot Assignments View  118
Auto Mode  46
Auto Pad  88
Aviom folder  12, 35

B
baud rate  22, 26, 135
blue A-Net icon  53
bracket icon  97
building

Elvis has left the  58

C
C4dio

Sample Rate Converter  73
C4dio card  4

sample rate converter  4
C4dio Card  72
C4o

Output Level Settings  80
C4o Analog Output Card  79
cable

DB9 null modem  21
Cable

RS-232  136
cable pinout  21
cancel

Firmware Update  32
Cancel Waiting button  31
Card Configuration

6416Y2  87
Card Configuration window  134
Card Mode  88
cards

AllFrame I/O  41
card slot  70
change a Slot range  67
change gain

6416m  98
Changing Column Widths

Network Overview  53
Channel Name  96, 100, 110
Channel Name column  118
Channel Name field  115
channel on/off  110
channel pair

6416Y2 card  86

channels 9-16 disabled
6416Y2 card  84

Channel Settings, 6416m  98
Channel Settings Menu  115, 116
channel strip  98
channel strip parameters  115
Ch column  96, 99
checksum  30
choosing devices to update  30
Clear  125
Clear All Device Presets  116
Clear All Input Channel Names  115
Clear All Matrix Slot Assignments  95
Clear All Output Channel Settings  80
Clear All Output Matrix Assignments  107
Clear All Scenes  126, 129
Clear button  112
Clear Channel Settings  99, 115

clear all  115
Clear Device Preset  116
Clearing a Device Preset  112
Clear Input Channel Name  115
Clear LED Device Identify  55
Clear Matrix Assignments  95
Clear Matrix Slot Assignments  115
Clear Output Level Settings

AllFrame  80
Clear Scene  129
Clear Text  113, 115, 128
Clock  46
Clock Error  47, 92

6416dio  92
Clock Master  38, 41, 46, 57, 65, 120
clock source  92
Clock source  38, 120
Clock Source  4
Close All  50
Close command  48
Close Window  61, 113, 128
CL Series  89
comments  38, 120
Comments  52, 60
Communication Setup  22, 24

6416Y2  25
Compatibility  126

projects  41
Scene  127

Compatible Devices
VDC  132

Completed Devices  31
COM port  21, 22, 28, 44
Computer Requirements  6
configuration  40, 120, 130

m-control  82
conflict

Slot activation  112
Connecting For the First Time  28
Connect to Network  43
contact closure  4, 75, 77
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contextual menu  56
Control Group  52, 60, 69, 89
Control Master  2, 21, 24, 38, 41, 46, 57, 65, 120, 124, 134

6416Y2  81
DIP switch  23
Managed  22
m-control  83

Control Panel
Windows OS  11

control panel cover  24
Copy  62
copy/paste text  62
Crossover Cable  136

wiring  137
Cut  62
Cut, Copy, Paste

Scene  123

D
DB9  2, 137

pinout  136
DB9 cable  21
DB9 serial cable  89
Deactivate a channel  67
Deactivate All Input Channels  115
Deactivate All Output Channels  116
Deactivate Input Channel  115
Deactivate Output Channel  116
Deactivating Channels  67
default install location  10, 12
default location

firmware update  35
default name  111
Demo Project  3, 12
Device column  118
Device Column  56
Device field  100
Device Identify  54, 62
Device Manager

Windows OS  28
Device Menu

Network Overview  62
Device Number  52
Device Overview  64, 96, 114
Device Preset  38, 39, 40, 41, 64, 81, 94, 96, 99, 110, 111, 

116, 120
ASI  106
matrix assignments  101
output levels  79
rename  112

Device Presets (Show All)  114
Devices

filter  58
devices in the network  120
Device Type  30, 52
Device Update  12
Device Window  13, 14, 16, 63

6416Y2  82, 85

User Label  59
Device Window Menus  113
Device Window Views  96
digital audio workstation  120
DIP switch  22, 25, 81, 134

6416Y2  86, 88
6416Y2 card  26
stereo link  97

DIP switch control
6416Y2 card  27

disable m-control  25
Disable RS-232

VDC  22
Discard  43
Documents folder  12
double dash symbol  94, 95
download  35
drag  53
Drivers  12

E
editing projects

offline  38
editing text

Scene  123
edit lock  55, 114
Edit Menu

Device Window  113, 128
Network Overview  62

edit notes  123
Edit Numeric ID...  56
egg

Easter  98
Empty  123
Empty Scene  125
Enter button  22
error

Slot activation  112
Escape key  123
Euroblock

Standby  75, 77
Euroblock connector  4
Event Log  14, 19, 20, 50, 133

saving text  133
exclamation point icon  36, 53
Exit  46, 49
exit Firmware Update  32
Exit Setup  11
external clock  4
External Clock  46, 47, 72, 73, 78

F
F6 Modular I/O Frame  2, 21, 24, 70
Fab Four  102
Failed Devices  31
File Menu

Device Window  113, 128
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Firmware Update  33
Network Overview  61
Workspace  49

Filter
Device Type  57
Network Overview  57
reset  58
Slot Range  60
Uncheck All  58

Filter Dialog Box  58
Filter On  58
Filter Settings  57, 58, 60, 62, 134

project  58
Finish button  31
Firmware  2, 5, 33

roll back  20, 35
Firmware Report  33
firmware roll back  36
Firmware Update  14, 20, 21, 35

6416Y2  26, 81
cancel  32
default location  35
m-control  83
Print report  33
time remaining  32

Firmware Update Fails  31
firmware update file  12
Firmware Update Utility  29, 30
Firmware Update Window

close  32
firmware version  30
folder  39, 120

project  38, 39
Scene, Device Preset  38

folders  12
Front Panel DIP Switches

6416Y2 card  25
front panel LED flashing  62
Front Panel Lock  55
FTDI USB Driver  12

G
Gain  98, 110, 115
gain range  88
garden gnome  96
gimme back

that filet o’ fish  110
GPIO  131, 132
gray Status icon  54, 75
green channel LED  68
green LED icon  131
green OK  122
Grids  65

H
Hardware Standby  77
Hardware Standby Active  77, 78

Help
mono, PMC 1255  51

Help Menu
Workspace  51

Hub  91

I
ID  46
in  38
incompatible device  36
Input Assignments  68
input module

stereo link  97
Input/Output Grids  65
Inputs and Outputs  114
Inputs Assigned to Slot  119
Input Slot Range  52, 53
Inputs to Network  64, 66, 96, 109, 114
Installation Location  9
Installing Pro64 Network Manager  6
install location, default  12
Internal Clock  46, 85, 92
invalid Scene  126
I/O Card  70

AllFrame  70, 110
I/O Grid  65

AllFrame  66
I/O routing  18, 117

L
Labels  59
LED Device Identify  54, 62

clear  55
LED flashing

front panel  62
LED icon  131
License  8
Link a Channel Pair  97
Locate Update Files  33
Location  30, 38, 52, 58, 59, 120
Lock All Front Panels  55
Lock All Scenes  125, 129
Lock Column

Scene  122
Locked Scene  121, 123, 124
Lock Front Panel  55, 114
lock icon  55, 114
Locking a Scene  124
Lock Scene  125, 129
Lock/Unlock

Front Panel  55
Log  14, 19, 133
Log file  50
Low Cut  98, 110, 115
LS9 console  89
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M
M7CL-ES  89
Mac OS  6
Maintaining a v3 Network  35
Managed button  22
Managed Mode  26

6416Y2  26, 27
Manage Slot Assignments  104, 105
Manual Mode  1
Manual Pad  88
matrix  38, 120
Matrix  58, 60, 67, 68, 100, 101, 102, 110
Matrix Assignment  94, 97, 103, 110

Clear  107
Output  101

Matrix Assignments - ASI  103
m-control  25, 27, 69, 82, 83, 87, 88, 89

Control Group  89
Control Master  83
during firmware updates  83
troubleshooting  134

m-control configuration  82
MCS  88
MCS Sync  93
Menu Commands

Workspace  49
MH10  110

Port names  120
MH10 Merger Hub  64, 91, 114
MH10/MH10f Merger Hub  56
Mic level

AllFrame  79
Mic Preamp

AllFrame  98
channel strip settings  98

mic preamp settings  110
clear all  99

MIDI  131, 132
momentary switch  4
monitor

A-Net Slot  93
RCI  93

multi-zone monitor mix  103
mute  120, 124

audio output  120
Mute  98, 110, 115
Mute All  47, 49
MY8  88
MY8 mode  84
MY8, MY16 mode  84
MY16  88
MY expansion slot  134

N
name a Scene  123
Net Framework Setup  135
Network Clock  46, 85, 92

network configuration  120
Network menu  37
Network Menu

Workspace  49
Network outputs

mute  120
Network Overview  13, 14, 36, 50, 52, 63

filter  57
User Label  59

Network Overview Menus  61
Network Report  61
Network Slots

remote controlled  89
Neutrik EtherCon. See EtherCon
New Device  56
new firmware available  30
New Project  38, 49
No Active Input  100, 101
Notes

Scene  121
null modem. See Crossover cable
null modem cable  21, 28, 135
Null modem cable  136, 137
null modem DB9 cable  2
Number Column

Scene  122
Number (No.) column  121
Numeric ID  30, 38, 46, 56, 57, 120

O
Offline  36, 47, 49

editing projects  38
Offline LED  37
offline/online  28
Offline to Online  41, 42
OK  36, 67
OK icon  121, 122, 126
old firmware  5, 29
On

Standby  76
online  35, 36
Online  49
Online LED  37
Online/Offline  126
Online/Offline Status  46
Online Support  51
Online to Offline  42
Online vs. Offline  37
Open Project  49
Open Windows List  50
output level

AllFrame  79
Output Levels

AllFrame  79
Output Level Settings  80

Clearing  80
Output Matrix Assignment  101

Clear  107
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Output Module Settings  116
Outputs From Network  64, 96, 99, 100, 114

6416Y2 card  109
Outputs from Network view  107

Matrix  101
Output Slot Range  52, 53, 60
Outputs Using Slot  119
Overview  13, 15
overwrite  40

P
Pad  98, 99, 110, 115
Pad Mode  88
Parallels  6
Paste  62
PC

connecting  23
PC control  134
PC keyboard  50
PDF  51
Personal Mixer  103
Phantom Power  98, 99, 110
Phase  98, 110, 115
pinout  21
Pinout

RS-232  136
PM1D  88, 134
Port names

MH10, ASI  120
Port Names  64, 96, 114
preamp control  82

Control Group  89
preamps  98
Preferences  50
preset

rename  112
Presets  39, 110
Presets Menu  116
Print

Firmware Update  33
print a report

Network Overview  61
Print Device Info  61, 113
Print Preview

Device Window  61, 113
Network Overview  61

Pro16  6, 90, 103
Pro16 Outputs  105, 106
Pro16 Zone

ASI  90
Pro64  6
Pro64 network  40
Pro64 Network Manager enabled

6416Y2 card  27
Pro64 Network Manager folder  12
Pro64 Update Tool  21
Progress Bar  31
project  42, 120, 129, 130

go online  42
window position  38

Project  38, 42, 44, 45, 110
Filter Settings  58
save as  49

Project Compatibility  41
Project Scenes  39
Project Scenes folder  123

Q
quit  48
Quitting the Installer  11

R
RCI  64, 69, 88, 96
RCI/MCS sync  93
RCI Remote Control Interface  56, 93
ReadMe  8
Recall button  112
Recall Device Preset  116
Recalling a Device Preset  112
Recalling a Scene  124
recall time

Scene  120
red dot  73
red exclamation point  36, 53, 122
red Mute All  49
red square icon  57
Refresh Update Files  33
regedit  135
Remaining Updates  32
Remote Control  52, 60, 69, 88
remote preamp control  82
Removing the Application  11
Rename a Device Preset  112
Renaming a Scene  123
Requirements  6
Reset filter  58
roll back firmware  20, 36
RS-232  2, 21, 22, 26, 42, 131, 132, 135

null modem cable  135
RS-232 Cable  136
RS-232 Connections  136
RS-232 pinout  21
RS-422  131, 132

6416dio  23
RTFM  1, 3

S
sample rate  1
Sample Rate  13, 46, 47, 60, 67, 90, 93, 101, 120
sample rate converter

AllFrame C4dio  4
Sample Rate Converter

C4dio  73
Save button  112
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Save Device Preset  116
Save Project  41, 49
Save Scene  129
Saving a Device Preset  111
Saving a Project  38
Saving a Scene  123
Saving Event Log  133
Scene  38, 39, 41, 79, 94

AllFrame I/O cards  126
Clear  125, 128
Clear All  126
compatibility  127
Cut, Copy, Paste  123
editing text  123
Lock  124
Lock All  125
matrix assignments  101
recall  124
recall time  120
red exclamation point  122
Renaming  123
transitions  120
update  124
Validate  128
Working Offline  126
Working Online  126

Scene Compatibility  126
Scene Manager  14, 17, 50, 120, 121, 122, 124, 125, 126
Scene Manager Menus  128
Scene Name  121
Scene Name Column  122
Scene Notes  121, 122, 123
Scene Valid  121, 126
Scene Valid Column  122
Scene Window  13
Select box  35
Select Slot dialog box  68
Send  44
Send Settings to Network  44
Serial Adapter  21
serial cable  22
Serial Interface  89
serial port  2
Service Pack 3

Windows XP  6
Setup

RS-232  22, 24, 25
shortcut  15, 16, 17, 18, 19, 47, 55
Show All  58, 114
Slot  38

VDC  19, 130
Slot 1-16  67, 104
Slot 17-32  67, 104
Slot 33-48  67, 104
Slot 49-64  104
Slot activation conflict  112
Slot Assignments  104, 117

clear  95
Slot Assignments View

Audio Slot Manager  118

Slot column  97, 118
Slot field  100
Slot Range  15, 52, 53, 60, 67, 110

change  67
Filter  58, 60

Slots
6416Y2  85, 86
VDC  130

Slots and I/O Routing  117, 118
Slots and I/O Routing View  119
Slots available  47
Software License  8
Sort  53, 58
SRC  4, 73
Standby  78

AllFrame  75
Euroblock  77
F6 Front Panel  76

Standby Euroblock
AllFrame  75

Standby Mode  72, 76
AllFrame  4

Standby Mode Off button  76
Standby momentary switch

AllFrame  75
Status  36
Status Bar  13, 15, 16, 46, 58, 114

Device Window  65
red Mute All  49
Workspace  46

Status column  82
Status Column  53
Status icon  52, 65, 134

6416Y2  86
6416Y2 card  81
gray  75

Stereo Link  115
6416Y2  86

Stereo Link Off  97
Stereo Link On  97
Stereo Links  97

6416Y2  97
stereo pair  97
SW8  26
SW9

6416Y2  26, 81
Switch Block 9  81
Sync

MCS  93

T
Text entry  97
the  41
time remaining

Firmware Update  32
time to update  29
Tools menu  4
Tools Menu  20, 114

Workspace  50
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Tools Menu - 6416Y2 Card  115
transitions

Scene  120
Transmit and Receive range

6416Y2  26
Troubleshooting  134

U
Uncheck All

filter  58
Undo  62, 113, 128
uninstall  7
Unlink a Channel Pair  97
Unlock All Front Panels  55
Unlock All Scenes  129
Unlock Front Panel  55, 114
Unlock Scene  125, 129
Unsaved Project  42
up  26
update  29
Update All  29, 35
update a Scene  124
Update Firmware  2, 20, 50
Update Options Menu  33
Updating a Device Preset  112
Updating Devices window  31
UPD extension  12
Upload  44
USB  2, 3, 21, 42
USB cable  24
USB driver  12
USB Serial Adapter  22
USB-to-RS-232  2, 6, 21, 28, 31, 134, 135
Use Default Update Files  33
user-created files  11
User Label  52, 59, 64, 65

Device Window  64

V
v2.xx firmware  2, 36
v3.xx firmware  36
v5.xx firmware  2, 5, 21
Validate All Scene Settings  129
Validate Scene Settings  129
Validating Scenes  127
VDC  19, 22, 50, 130

Disable RS-232  22
RS-232 pinout  136

VDC Compatible Devices  132
VDC Destination  130, 132
VDC Slot  130, 131
VDC Source  130, 132
VDC Type  130, 131
version 3.0  2
View

Device Window  64
View Menu

Device Window  96, 114, 128

Network Overview  62
Views  16, 64

Device Window  96
Virtual Data Cable  14, 19, 22, 26, 38, 120

6416Y2  83
Virtual Data Cable Monitor  50, 130

W
website  3
What Gets Installed  12
Window Commands  48
window position

project  38
Windows 7  10, 135
Windows List  50
Windows Menu

Workspace  50
Windows OS  11
Windows OS Control Panel  7
Windows OS Device Manager  28
Windows XP  10, 135
Wiring a Crossover Cable  137
Word Clock  4, 72, 78, 92
Working Offline  37

Scene  126
Working Online  37

Scene  126
Work Offline  29, 42, 49
Work Online  28, 42, 43, 45, 49
Workspace  13, 14, 46
Workspace Features  46
Workspace Menu Commands  49
Workspace Status Bar  46

Y
Yamaha  26, 82, 88
Yamaha device  56, 84, 85, 88
yellow A-Net icon  54, 82
yellow LED

6416Y2 outputs  85
yellow LED icon  131
yellow square icon  57
yellow Status icon

6416Y2  86
yellow warning triangle  76
Yes

  112
You

...are here  41

Z
Zone  103

ASI  90, 106



146 Pro64 Network Manager User Guide

SOFTWARE LICENSE AGREEMENT

This software license agreement (this “Agreement”) is made by and between AVIOM, INC., a 
Delaware corporation (“Aviom”), and the individual or entity desiring to install or use the Software (as 
defined below) (“Licensee”).  By clicking the “I Agree” button, Licensee: (1) represents that Licensee has 
read this Agreement in its entirety and understand its terms and conditions; and (2) agrees to each of the 
terms and conditions of this Agreement.  If you do not agree to each of the terms and conditions of this 
Agreement, then you must click the “I Decline” button and you may not install or use the Software.

Definitions.

“Aviom Product” shall mean the product of Aviom into which the Firmware is intended 
to be installed.

“(a)	 Firmware” shall mean the firmware provided by Aviom that is intended to be installed 
into a specific product of Aviom.

“(b)	 Installation Software” shall mean the software provided by Aviom to enable Licensee to 
install the Firmware into the Aviom Product.

“(c)	 Software” shall mean both the Installation Software and the Firmware, collectively.

Grant of License1.	 .  Subject to the terms and conditions of this Agreement, Aviom grants Licensee 
a limited, non-exclusive license to the object code version of the Software (the “License”).  The License 
permits Licensee to install and use the Installation Software on a single workstation and use the Installation 
Software to flash the Firmware into the Aviom Product(s).  The License also grants Licensee the right to use 
the Firmware on all Aviom Products owned by Licensee.  Licensee may also use the documentation included 
with the Software, if any, (e.g. help files, release notes, and readme.txt files) (collectively, “Documentation”) 
as is reasonable and necessary for Licensee to use the Software.  

Compensation2.	 .  There is no charge for use of the Software by Licensee under the terms and 
conditions of this Agreement.  

Ownership3.	 .  Licensee acknowledges that: (a) the Software is and shall remain the exclusive 
property of Aviom and Aviom’s successors and assigns; (b) Licensee has no right or interest in the Software 
or the Documentation other than as expressly granted in this Agreement; (c) nothing in this Agreement shall 
be construed as a sale of the Software or the Documentation to Licensee; and (d) all intellectual property 
rights shall remain with Aviom and the Agreement shall not transfer any intellectual property rights in, or 
associated with, Software or the Documentation to Licensee. 

Transfer of License; Copy Protection4.	 .  Licensee may not rent, loan, transfer, sublicense, lease or 
otherwise distribute or operate all or any part of the Software to or for the benefit of any third party.  Licensee 
may not assign all or any part of its rights or obligations under this Agreement without Aviom’s prior written 
consent and any attempt to the contrary will be void and a material breach of this Agreement.  Aviom may 
withhold such consent in its sole discretion.  

Other Restrictions.  Licensee may not reverse engineer, decompile, disassemble, modify or create derivative 
works of all or any part of the Software or otherwise derive the source code to all or any part of the Software.  
Without limiting the generality of the foregoing, Licensee shall not use a debugging tool to examine, operate 
or alter all or any part of the Software or run all or any part of the Software through a disassembly or source 
extraction system of any kind or create any derivative work of all or any part of the Software.  Licensee 
agrees that any information obtained in violation of the restrictions as set forth in this Section 6 will be 
Confidential Information automatically and irrevocably deemed assigned to and owned exclusively by 
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Aviom.  Licensee will ensure that all marks, notices or legends pertaining to the origin, identity or ownership 
of the Software or the Documentation remain intact and clearly legible.  Notwithstanding anything contained 
in this Agreement to the contrary, if Licensee is located in the European Union and Licensee determines that 
access to the source code to the Software is necessary to achieve interoperability of the Software with other 
programs, then Licensee may reverse engineer the Software provided that: (a) Aviom has not already made 
available to Licensee the information necessary to achieve interoperability; and (b) Licensee limits its reverse 
engineering activities to those parts of the Software which are necessary to achieve interoperability with such 
programs.
Copyright.

The Software and the Documentation contain proprietary material of Aviom and/or material (a)	
that other software and/or information suppliers have licensed to Aviom for use in the Software.  This 
material is protected by copyright and other laws respecting proprietary rights.  Aviom and/or its licensors 
retain all rights in the Software and the Documentation, including (without limitation) all copyright and 
other proprietary rights worldwide in all media.  Licensee may not use all or any part of the Software or the 
Documentation except as expressly permitted under this Agreement and under U.S. and/or other applicable 
copyright laws.

While Licensee may make a reasonable number of copies of the Software and the (b)	
Documentation solely for archival/back-up purposes, no part of the Software or the Documentation may 
be used, reproduced or duplicated in any medium or format beyond the express terms of this Agreement 
without prior written authorization from Aviom.  Any use or reproduction not authorized by this Agreement is 
prohibited and shall immediately terminate this Agreement.

Licensee acknowledges that the Software and the licensed materials therein are highly (c)	
proprietary in nature and that unauthorized copying, transfer or use may cause Aviom irreparable injury that 
cannot be adequately compensated for by means of monetary damages.  Licensee agrees that any breach 
of this Agreement by Licensee may be enforced by Aviom by means of equitable relief (including, but not 
limited to, injunctive relief) without the necessity of posting any bonds in addition to any other available 
rights and remedies.

Termination5.	 .

Termination(a)	 .  If Licensee: (i) makes or distributes, or fails to prevent others in its control 
from making or distributing, copies of the Software or the Documentation (except as expressly permitted by 
this Agreement) or modifications or derivations thereof; or (ii) breaches any provision of this Agreement, 
then this Agreement shall terminate automatically.

Effect of Termination.  Upon any termination of this Agreement, Licensee shall: (i) immediately discontinue 
use of the Software and the Documentation; (ii) remove the Installation Software and the Documentation 
from all of Licensee’s workstations; and (iii) delete and destroy all copies of the Software and the 
Documentation in its possession or control. Sections 4, 5, 6, 7, 8(b) and 9 through 12 shall survive the 
termination or expiration of this Agreement for any reason in accordance with their respective terms.  

Disclaimer of Warranties6.	 .  AVIOM LICENSES AND PROVIDES THE SOFTWARE AND 
THE DOCUMENTATION TO LICENSEE ON AN “AS-IS” BASIS.  AVIOM HEREBY DISCLAIMS 
ANY AND ALL WARRANTIES AND CONDITIONS WITH REGARD TO THE SOFTWARE AND THE 
DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, ALL IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, ACCURACY, 
TITLE AND NON-INFRINGEMENT.

Limitations of Liability7.	 .

General(a)	 .  IN NO EVENT WILL AVIOM BE LIABLE FOR DAMAGES ARISING OUT 
OF THE USE OR LICENSING OF THE SOFTWARE OR THE DOCUMENTATION OR ARISING 
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UNDER THIS AGREEMENT, WHETHER IN TORT, CONTRACT OR OTHERWISE, TO LICENSEE OR 
ANY OTHER PERSON OR ENTITY INCLUDING ANY DAMAGES CAUSED TO AVIOM PRODUCTS 
FROM USE OF ALL OR ANY PART OF TH E SOFTWARE.

Consequential Damages, Etc.(b)	   AVIOM SHALL IN NO EVENT BE LIABLE 
TO LICENSEE OR ANY OTHER PERSON OR ENTITY FOR ANY LOST PROFITS, OR 
CONSEQUENTIAL, INCIDENTAL, INDIRECT, PUNITIVE, SPECIAL, OR SIMILAR DAMAGES, 
INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF DATA, DAMAGES TO 
HARDWARE INCLUDING BUT NOT LIMITED TO AVIOM PRODUCTS, IMPAIRMENT OR 
LOSS OF GOODWILL, WORK STOPPAGE, COMPUTER FAILURE OR MALFUNCTION, AVIOM 
PRODUCT FAILURE OR MALFUNCTION, LOSS OF WORK PRODUCT, OR ANY AND ALL OTHER 
COMMERCIAL DAMAGES OR LOSSES, DIRECT OR INDIRECT, WHETHER IN TORT, CONTRACT, 
OR OTHERWISE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

THE LIMITATIONS OF LIABILITY SET FORTH IN THIS SECTION (I) REFLECT (c)	
AN ALLOCATION OF RISK GIVEN THE AMOUNTS PAYABLE UNDER THIS AGREEMENT 
AND (II) SHALL REMAIN FULLY OPERATIVE EVEN IF THE LIMITED REMEDY SET FORTH 
IN THE AGREEMENT FAILS OF ITS ESSENTIAL PURPOSE OR IS OTHERWISE HELD TO BE 
UNENFORCEABLE.

Export Regulations8.	 .  The transfer of technology across national boundaries is regulated by the U.S. 
Government.  Licensee agrees that Licensee shall not: (a) acquire, ship, transport, export or re-export the 
Software, directly or indirectly, into any country in violation of any applicable law (including, but not limited 
to, the United States Export Administration Act and the regulations promulgated thereunder); or (b) use the 
Software for any purpose prohibited by such laws.

Miscellaneous9.	 .

Governing law; Jurisdiction(a)	 .  The validity, interpretation, rights and obligations of the 
parties and any dispute arising under this Agreement shall be governed by the laws of the Commonwealth 
of Pennsylvania applicable to contracts between residents of Pennsylvania and wholly performed in 
Pennsylvania.  Neither the United Nations Convention on the International Sale of Goods, the 1974 
Convention on the Limitation Period in the International Sale of Goods, nor any amendment or protocol to 
either of the foregoing shall apply to this Agreement or the activities undertaken under or in respect of this 
Agreement.  The state and federal courts with jurisdiction over Chester County, Pennsylvania shall have 
exclusive jurisdiction over any case, controversy or dispute concerning this Agreement or its performance or 
the Software; provided that Aviom may seek injunctive relief in any court of competent jurisdiction.

Severability(b)	 .  If any provision of this Agreement shall be determined to be void, invalid, 
unenforceable or illegal for any reason, then the validity and enforceability of all the remaining provisions 
hereof shall not be affected thereby.

Failure to Exercise Rights(c)	 .  The failure of either party to exercise any of its rights under 
this Agreement for a breach thereof shall not be deemed to be a waiver of those rights or a waiver of any 
subsequent breach of the same or any other provision.

Titles(d)	 .  The titles of the Sections of this Agreement are for convenience only and do not in 
any way limit or amplify the terms and conditions of this Agreement.

Entire Agreement(e)	 .  This Agreement constitutes the entire understanding between the parties 
with respect to the subject matter of this Agreement and supersedes any and all prior and contemporaneous 
understandings, statements, warranties, representations and agreements, both oral and written, relating 
thereto.  This Agreement cannot be modified except in a writing signed by the party against whom 
enforcement is sought.
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